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Welcome

Congratulations!
PedFast Technologies™ welcomes you to The Breeder’s Standard® 2022, the latest achievement in a 30-
year-long string of achievements by the World Leader in Animal-Related Software.

The Breeder’s Standard® 2022 is the sixteenth edition of our software, which was introduced in
December 1991.  Since its inception, PedFast Technologies (formerly known as Man’s Best Friend
Software) has prided itself on the fact that The Breeder’s Standard® is the technological leader in
kennel management software.  In 1991, we were the first program to embrace Microsoft ® Windows™.
In 1992, The Breeder’s Standard® was the first – and is still the only – kennel program ever to qualify
for the “Microsoft Windows Compatible” logo, tangibly showing our commitment to ease of use and
product quality.

The Breeder’s Standard 2007™ refined this further, with the addition of COMPOUNDEX™ (powerful
“sounds-like” matching on multiple words) and possessive-ignorant searching in the new DataSifter™
feature, and has extended our patent-pending technology into a duplicate-checking window on each
and every dog.

PedFast Technologies is the innovator in this industry.  Some of our achievements:

First Windows breeding software, The Breeder’s Standard®, 1991.

Only Windows breeding software to earn Microsoft Windows Compatible designation, 1992.

First kennel software to be 100% compliant with AKC recordkeeping rules, 1991.

First pedigree software to offer visual, intuitive pedigree entry, with our PedFast™ feature,
1991.

First pedigree software to store animal pictures and print on pedigrees, 1992.

First pedigree software to offer print-shop quality color pedigrees, 1993.

First full-featured cattery management software, The Cattery’s Standard™, 1994.

First animal related software to open an internet web site, www.mbfs.com (now
www.pedfast.com), 1995.

First pedigree software to offer multiple pedigree configurations with our MegaPed™ feature,
1996.

First company to offer interactive web-based pedigrees with NETigree®, 1997.
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First Windows-based horse stable management software, Equestrian’s Standard ®, 1997.

First, and still the only, full-time product support department in the industry, 1997.

First, and still the only, toll-free product support line in the industry, 1998.

First windows-based pedigrees-only entry-level product, InstaPed™, 1999.

First, and still the only, web-based cat show management system, EnterCat™, 2000.

First fully-customizable pedigree layout system, Pedcasso™, 2001.

First, and still the only, packaged custom pedigree layout sets, Pedigree Power Packs™, 2002.

First, and still the only, web-based full-powered kennel management software, The Breeder’s
Standard .NET®, 2004.

First full-powered ad-hoc reporting feature for kennel software, The Scoop™, 2005.

CompuPed™ Millennium, the premier animal genetics program for Windows, completed in
2005.

COMPOUNDEX™, the First and only, patent-applied for, possessive-ignorant animal name
matching technology, found only in The Breeder’s Standard® 2007 and newer, released in 2006.

First 100% Windows Vista compatible kennel program, including Vista compatible help, 2007.

TBS 2008, with the first five-generation instant pedigree entry window, 2007.

TBS 2012, the first 32 and 64 bit fully managed program for Windows, 2012.

PedCabinet™ file storage subsystem, 2019

New HoleFinder™ technology for rapidly finding and fixing missing pedigree ancestors, in TBS
2021, released in 2020.

Compliance Management enhancements, including automated litter and ownership report
compliance assessment, in TBS 2022, released in 2021.

And, as you can guess, we’re nowhere near done with innovating.  We’ve perfected what our
“competition” cannot yet conceive.

Copyright and License Agreement

This software is Copyright © 1991-2021 by PedFast Technologies.  All Rights Reserved.  No part of this
software may be duplicated for any reason or by any means, whether or not mechanical, under any
circumstance prohibited by law or the herein-captioned license agreement.  No employee (other than
the Owner) of PedFast Technologies is empowered to grant permission to copy contrary to this
notice.  Unauthorized copying is a violation of Federal Copyright laws and will be prosecuted
accordingly.

The Software discussed in this manual is also governed by the terms of a license agreement.  No use of
the software is permitted without complete agreement to all terms set forth in the License.  Opening the
envelope containing the program diskettes, or any other use of the software covered in this manual
shall be deemed complete acceptance of the license agreement covering the Software.  A copy of the
License Agreement appears here in this manual, and also in the install program which places The
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Breeder’s Standard® 2018 onto your computer, and you must indicate acceptance of the agreement in
order to install or use The Breeder’s Standard® 2021.

License Agreement

In consideration of the license purchase price of The Breeder’s Standard ® 2022 software product (the
“Software”), PedFast Technologies (the “Company”) grants you a conditional, limited and non-exclusive
license to use the Software. If you do not agree to all of the terms listed on this license, do not open
the envelope containing the program disk(s) or otherwise install or use the software on your
computer. Opening the envelope or installing any copy of the software will be considered
absolute evidence that you have accepted every term and condition of this license without
objection or reservation.

If you do not accept every term and condition of this license as written herein, your license to
use the software is revoked and you must return this software, with the envelope unopened, to
the point of purchase for full refund, less shipping and handling fees. This license is binding
agreement, and contains limitations of liability and imposes obligations upon you. Read
carefully before opening the disk envelope or installing.

License Terms and Conditions
You acknowledge that the Software, manuals, this license, and all other materials are Copyright © 1991-2020 by PedFast
Technologies.  All Rights Reserved.  You understand that ownership of the Software itself at all times remains with the
Company, and that this license grants you no ownership rights whatsoever to the Software, either now or in the future.  You
also acknowledge and agree that such copyright allows Company to require you to agree to all of the terms of this agreement,
and you voluntarily accept all of these terms. This license governs all aspects of the transaction between you and Company,
and not just the terms under which you may use the Software.  This license supersedes any license agreement that may bind
you with respect to a previous version of the Software, or any other Product we may produce, and the terms herein set forth
govern your use of all versions of the software from the time this license becomes effective.

You acknowledge that you have read all of the terms and conditions herein, and by opening the envelope containing the
program disk(s), you agree to them all.  You agree that any of the following acts: 1) Opening the envelope containing the
program disk(s) with the Software; 2) Installing a full or trial copy of the Program on any computer you own or have use of
(whether or not that use is authorized); 3) Receiving, either in written form or by electronic means, any codes capable of
activating the program; or 4) placing and tendering payment for (whether or not the payment is negotiable for any reason),
executes this contract with the same force and effect as your signature witnessed by a Notary Public.  In any dispute that may
arise, it shall be conclusive proof that you have read and assented to the entirety of this agreement, of your own volition, if any
of the acts mentioned in this paragraph have transpired.

You agree that this License is a binding contract, and you also agree to abide by every term and condition herein.  You agree
that, in the event that you violate any term or condition contained herein, your license will be permanently revoked (without
any compensation due or owing to you) and that you will be liable for any and all applicable damages set forth herein, plus any
penalties or damages allowed by law.

You agree that this document represents the entire agreement between you and Company.  You acknowledge that no
employee, agent, assign, dealer or distributor of the Company has the right to change, add or delete any provisions of this
license and expressly confess that any and all verbal or written statements not in this license are not binding upon the
Company in any way and are invalid and without value. You understand and agree that this contract is the final arbiter of both
Company’s and your rights and responsibilities under this contract.

No modification to this contract shall be valid unless signed IN ORIGINAL by both you and the chief executive officer or owner
of Company, and witnessed by a Notary Public.  Nothing in this clause shall be interpreted to state that Company may not
unilaterally alter this license for any future versions of the Software, or that the terms of this agreement shall apply to any
other product you buy from Company.

This Software is distributed freely as a 14-day evaluation copy.  The software will cease to function after 14 days unless fully
activated with our protocol, and you agree that any attempt to defeat or circumvent this mechanism is a material violation of
this agreement and incurs damages under the law, and also as herein set forth.  However, the mere fact that you may have
received activation codes pursuant to a purchase and failed to enter them into the Software shall not transform any sale into
an evaluation.
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This software is made fully active and permanent using activation code(s) provided to you by Company upon payment of the
purchase price in effect at the time, and your complete assent to these terms.  You agree that these codes are confidential, for
your use only, and you shall never make them available to any other party.

Once payment has been tendered to the Company for the Program, all sales are irrevocably final.  If activation code(s) have
been provided to you, it shall be conclusive proof that you have used these codes to activate the Program, and the sale may not
be reversed for any reason.

You are granted permission to distribute the program disks (or downloaded program) freely to others interested in
purchasing the software, provided that they do not manufacture a program that competes with the Software.  You can only
duplicate and distribute the disks themselves, or the download, which create the evaluation program.

You agree to load and/or use the registered version of Software on only one computer at a time.  You are allowed to have
backup copies of the Software to protect yourself from data loss.  Once purchased, you may install the software and use the
registration code(s) to activate it on up to three computers that you own, lease or lawfully may install such software upon,
provided that no more than one of these computers shall be running the Software simultaneously.

You agree not to loan the registered Software to any party, nor may you rent, lease or sublease it to anyone.  You agree never
to copy the registered software for the benefit of any other party for any reason.  You agree never to make any copies of the
printed Manuals for any reason.

If you sell or give away the registered Software, you must destroy every backup copy of the Software, and you agree to do
so.  You must notify the Company in writing within three (3) business days of such a sale or transfer, and must provide the
name and address of the actual purchaser or receiver of the Software.  Once you sell or transfer the Software, you may not buy
back or receive back the Software for a period of three (3) years, and you agree to this condition (However, you may of course
purchase another copy of the software from Company or any authorized dealer at any time).  You may not use somebody else’s
copy of the Software to access records or files made by your copy.

As soon as you sell the Software, you lose your license rights and all rights to use the Software.  However, clauses in the
License which restrict you from infringing Company’s rights to its copyright, trade dress or patents (granted or pending) still
apply and you agree that these terms will survive your loss of rights under this license, perpetually.

To the extent that such conduct exceeds the bounds of Fair Use under United States Copyright law, You may not sell give other
otherwise transfer or provide the Software to any party which produces a software product that competes with the Software,
to any employee, agent, assign, owner, shareholder, affiliate or any party with any kind of a relationship with such a person or
company, or to any party which contemplates producing a product that competes with the Software.  These same restrictions
apply to parties who intend to produce any product or products which rely on the databases produced by the Software for any
function whatsoever.

To the extent that such conduct exceeds the bounds of Fair Use under United States Copyright law, you agree that you will not
attempt to reverse-engineer or disassemble the Software or attempt to do so at any time.  You agree not to change any portion
of the Software, including, but not limited to, icons, dialog windows, error messages, menus, string tables and the serial
number(s) as embedded in various portions of the Software.  You agree that such a change, in addition to being a material
violation of this license agreement, is a violation of Federal Copyright and Trade Secret laws, and constitutes a crime.

You understand that the software employs various devices and algorithms designed to prevent infringements of Company’s
copyright by preventing the illegal use or copying of the Software.  To the extent that such conduct exceeds the bounds of Fair
Use under United States Copyright law, you agree not to remove, attempt to remove, defeat, attempt to defeat, circumvent,
attempt to circumvent or cause any party to attempt to remove or defeat or circumvent these mechanisms for any reason
whatsoever.  You agree that any act in violation of this clause damages Company in an amount which is impossible to
determine, and therefore shall be responsible to pay Company, as liquidated damages, and not as a penalty the sum of FIVE
HUNDRED THOUSAND DOLLARS ($500,000.00) per offense for any violation of this clause.

You agree that you will not create or offer for commercial sale any “add-on” product that uses these databases for sale or free
distribution without the express advance written permission of the Company.  Such permission may, at Company’s sole
discretion, be in the form of a Developer’s License, which you agree would at the sole discretion of Company require the
payment of additional fees.

You agree that Company has no obligation to issue you or any other party a Developer’s License, and that no part of this
License Agreement shall serve to impose such an obligation upon the Company, or entitle you to damages if Company refuses
to grant a developer’s license.

You agree that, since it is impossible to determine the effect of any violation of the above terms, that you will be liable for ONE
HUNDRED THOUSAND DOLLARS ($100,000.00) for each individual violation of the copy, lease and loan provisions above, all
as liquidated damages and not as a penalty.  You agree that, if you violate this license in any way, that Company may at its sole
discretion seek additional penalties and damages as permitted by law.
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You agree, if you pay for the software and services by debit card, electronic checking debit, electronic funds transfer, credit
card or charge card, that You permanently and irrevocably waive any and all right to cause a “chargeback” (that is, a disputed,
reversed or contested charge) against this purchase for any reason whatsoever against Company or other reseller of this
license, effective as soon as You click on the “I ACCEPT” button. You agree that, if you institute such a “chargeback”, it
constitutes a material violation of this license, and damages Company in ways impossible to calculate, and with long-term
adverse effects to the Company.  Therefore, You agree to pay, and Company agrees to accept in compromise, for each
chargeback you may issue or directly or indirectly cause to be issued against Company, the amount of EIGHT THOUSAND
DOLLARS ($8,000.00) to Company (or the party selling you this license), as liquidated damages and not as a penalty.  You
expressly confess, in the event of such a “chargeback”, that such chargeback constitutes fraud and confess such fraud.  You
agree to pay all costs incurred by Company or the seller of this license in collecting these amounts.

If You are a corporation, you agree that any corporate indemnification, explicit or statutory, against any and all officers,
employees or owners of the corporation is waived, and the person(s) opening the envelope and/or using the software jointly
and severally agree to be personally bound by this agreement. You agree that any judgment or arbitration award obtained
against You for violating this license is a finding of fraud, confess such fraud, agree that such a judgment is fair, proper and not
dischargeable or modifiable in any proceeding under the United States Bankruptcy Code, and agree to waive the right to
notice, response or contest of any motion by Company or its attorneys to lift a stay so imposed against it.

You agree that you purchase this software “AS IS”.  You also agree that the only warranty provided is as follows:  for a period of
not more than THIRTY (30) DAYS after you purchase the software, the program disk(s) upon which the software is delivered
to you will be free from defects in material or workmanship.  Your sole remedy in a warranty claim is replacement of the
defective disk(s).  This warranty is not transferable.

You agree that any trait analysis report, inbreeding report, or any other number or report produced by the Software is
produced as an informational tool only.  Company does not represent that the Software is able to accurately predict the
outcome of any mating, and you acknowledge and agree that it is impossible to do so.

You agree to hold Company harmless as to the results of any mating in which you consult the Software or reports generated
therefrom in determining whether or not to actually effectuate the mating.  If you use the Software on the behalf of another
party, or permit another party to use the Software while on your computer, you agree to indemnify and hold Company
harmless for the results obtained by that party.

You are notified that any Bill of Sale or Contract produced by this software are not guaranteed to meet the legal requirements
of your locality, or the requirements of any governmental agency, or the requirements of any kennel club, and expressly hold
Company harmless for their use.

You understand that contract text is not provided to you, and that you are expected to retain the services of a licensed attorney
in your locality to draft contract language suitable to your needs.  You, in any event, acknowledge that Company has no liability
in any circumstance with respect to the use or enforceability or legality of any Contract or Bill of Sale produced by the
Software.

NO OTHER WARRANTY IS PROVIDED. COMPANY DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO, MERCHANTABILITY OR FITNESS FOR PARTICULAR PURPOSE. COMPANY IS NOT
RESPONSIBLE FOR ANY INCIDENTIAL OR CONSEQUENTIAL DAMAGES SUSTAINED BY YOU OR ANY OTHER PARTY AS
RESULT OF USING OR POSSESSING THE SOFTWARE, EVEN OF COMPANY HAS BEEN NOTIFIED OF THE POSSIBILITY OF
SUCH DAMAGES.

THIS SOFTWARE IS BUSINESS SOFTWARE, USED IN THE BUSINESS OF MANAGING KENNEL. YOU AGREE THAT THIS
SOFTWARE HAS ABSOLUTELY NO PERSONAL OR HOUSEHOLD USE WHATSOEVER, AND THAT THE CONSUMER
PROTECTION LAWS OF THE UNITED STATES, OR OF ANY STATE, ARE INAPPLICABLE TO THIS TRANSACTION.

You waive and abandon any and all warranty rights under the law that may be available to you and exceed the scope of the
above warranty.

You agree that, in the event of a warranty claim not herein waived, or any claim held non-waivable by a court of law with
proper jurisdiction to enforce this agreement, Company’s complete liability will extend to no more than the actual price paid
by you for the Software, EXCLUDING any shipping and handling charge.  You agree to hold Company harmless for any claim of
any kind with respect to the Software, its manual(s), warrant(ies) or operation.

You understand and agree that the availability and delivery of “support” is not included in the purchase price of the program,
and that any support services offered or rendered free of charge may be terminated or made available only for a fee at any
time.

“Support” includes, but is not limited to, assistance with installation, operational questions, problems encountered by you in
using the software, accuracy of the manual or the Software, or any other thing which may cause you to seek aid from Company



The Breeder’s Standard® 2022 User’s Manual Welcome

in the installation or use of the Software.  Company is free to change its policies regarding “support” at will, and you hold
Company harmless for the effects of such a policy change.

You agree that, in the event that any part of this license is declared by a court holding proper jurisdiction under this agreement
to be illegal or unenforceable, only that very part so declared shall be invalid, and the rest of this license shall continue in full
force and effect, as if the illegal or unenforceable clause were never included therein.

You agree that this license and ALL of its terms shall binding upon your employees, successors, assigns, or transferees.

You agree, if purchasing or otherwise receiving the Software from a party other than Company, that you will be bound by all
the terms herein.  If you DO NOT AGREE, your license is revoked and you must return the Software to the party from whom
you purchased it.  In that event, you agree to hold Company harmless as to damages or compensation, inasmuch as full
agreement to all the terms of this license is a prerequisite condition of your permission to use this software.

You agree that this license shall be interpreted and enforced under the laws of the United States of America and the
State of Illinois, as appropriate, but excluding conflict of law principles.

You agree that any action under this agreement may not be combined with the claims of other persons into any sort of
combined or class action with any other party for any reason or cause whatsoever. You waive all rights to class

action against Company. In the event that you participate in combined or class action against Company, you agree
that Company is entitled to have such an action dismissed, with prejudice, and shall receive its costs and reasonable
attorney fees from all putative class plaintiffs, jointly and severally.

You and company mutually choose to submit to the exclusive personal jurisdiction of the United States District Court
for the Northern District of Illinois, or the Illinois Circuit Court in the county of Company’s principal place of business
at the time of the action, as appropriate to the jurisdiction of the question to be decided. You agree that, if you bring
an action in any other venue, Company may enter into said court, cause such action to be dismissed, and may recover
all of its costs, including reasonable attorney’s fees, from you.

You agree that any action against Company for any reason, whether or not related to the Software or this license must
be brought within ONE (1) year after the date the Software was purchased from Company or such action shall be
forever barred, and Company agrees that any breach by you of this license not litigated within one (1) year of its
discovery by Company shall be likewise forever barred, with the exception of an infringement of copyright, patent or
trade dress, which shall be actionable solely according to the statutes of limitations set by the laws of the United
States of America for infringements in force at the time of the infringement. This clause does not apply to any clause
in this agreement that sets forth different limitation period.

You agree that Company does not waive any rights it has herein by delaying enforcement of or not strictly enforcing its rights
herein against you or any other party.
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Getting Started

What you Need
Every computer program has prerequisites.  Here are ours:

Windows OS
The Breeder’s Standard® 2022 is designed to run correctly on the following Windows operating
systems:

Windows 8, 32 and 64 bits.

Windows 8.1, 32 and 64 bits.

Windows 10, 32 and 64 bits.

…And Newer Operating systems.  If unsure you can Contact Product Support to see if your
version of Windows is supported.

The Breeder’s Standard® 2022 does not support Windows XP, Vista or 7.  We recommend that you have at
least 2GB of RAM, with 4GB or more preferable.

We recommend that you have at least 120MB disk space open for the initial install.

Generally speaking, any Windows compatible computer produced after January 1, 2015 should run The
Breeder’s Standard® 2022 without difficulty.

Installation: Ready, Set, Go!
In Windows, to install from our removeable media (CD-ROM or USB), you need simply to place the
Media into the drive or USB port.  The front-end will display all of the programs on the Media; you
simply need to choose the program that you wish to install.

To install from a download, you will end up with A Microsoft Installer (“MSI”) file.  You double click on
the MSI file to launch the installer.

Operate the installer.  You will be asked to agree to our Software License Agreement, and then when
you do, the program will be installed.
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Upgrading from Previous Versions
The Breeder’s Standard® 2022 does not work with versions older than 2012 as its predecessors did.  To
upgrade from programs older than 2012, you must follow these instructions:

1. Do not install The Breeder’s Standard® 2022 into the same folder where any previous version
resides.

2. You create the database first in The Breeder’s Standard® 2022, and then run the Migration
Wizard to copy over the data from the files that contained the database in older versions of the
program.

3. Then you verify the copied database.  When you are satisfied, you delete the old program and
all of its files.  You may want to create a backup of the data for emergency reasons.

Activation
Once your program is installed, you will have 14 days to activate the program.

If you have purchased the program, please understand that all sales are final and this 14 day period is not
trial. Trial periods are only allowed if you have not purchased the program before you installed. When

you purchase the program, you’ve purchased the program. Not activating purchased program does not
make it into trial.

If the program expires, you will not lose any data.  However, in order to work with the data, you will
have to activate the program.  You can activate the program at any time from when you first install it
going forward.

Activation using MyActivate™
MyActivate™ is a new service that PedFast Technologies offers to make your life easier.  Now, you have
the option to automatically activate The Breeder’s Standard® and any of the optional features bundled
inside the program (such as the Pedigree Power Packs™) by logging into our servers with your
MyPedFast™ ID that is linked to your purchase history.

Active Internet connection required.

To activate The Breeder’s Standard® 2022:

1. Click the Help Tab

Click the Activation button, which has an icon like this:

Clicking the button brings up the Activation window.
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The Activation window looks like this:

2. You then simply click the MyActivate™ button:

3. If you have not stored your MyPedFast™ ID and password before, MyActivate will ask you for it:

4. After you are signed in to MyPedFast™, MyActivate will retrieve your account history, and fetch
the program activation code and that for all add-ons you have purchased, and then let you
know.

In the event that you purchase an add-on, you can simply repeat this procedure.

Manual Activation
Your activation code email or sheet will contain the registered name.  This name must be entered
exactly as it is on the sheet, including capital and lowercase letters.

The control number is 6-7 digits long and must be entered exactly.

The activation code is 18 characters long and contains no character other than the numbers 0-9 or the
letters A through F.  Any “0” in the activation code is ZERO, not capital “o.”

Once everything is entered, the “activate” button will light up, and you may click it, which will activate
the program.

AutoUpdate™ III
The Breeder’s Standard® will use your MyPedFast™ login to access our servers and see if there are any
updates to The Breeder’s Standard®.  If an update is needed, The Breeder’s Standard® will pop up a
window to ask you if you wish to update.  Choose yes to update immediately; Choose No to delay for a
few days.
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Important: Please remember that product support is contingent upon running the latest patch
level of The Breeder’s Standard® Therefore, before contacting us with any questions or issues,
please ensure that you are on the latest patch level. If you start up the program and are not
asked to update, you are on the latest patch level.

Once your program is installed, you will have 14 days to activate the program. If you have purchased the
program, please understand that all sales are final and this 14-day period is not trial. Trial periods are
only allowed if you have not purchased the program before you installed. When you purchase the
program, you’ve purchased the program.

If the program expires, you will not lose any data.  However, in order to work with the data, you will
have to activate the program.  You can activate the program at any time from when you first install it
going forward.

Using The Breeder’s Standard® for the First Time

Opening database
The first time that you start The Breeder’s Standard® 2022, the program will ask you to open or create
a database file.  Also, while you are working in the program, you may choose to open another database
by clicking on the The File Menu and choosing to open a database.  When you do either of these things,
you will receive the Database Tasks window.

If you’ve previously created a database for The Breeder’s Standard® 2022, and you’ve forgotten where
it is on your computer, the program will search all of the drives in your computer to find it.

The Database Tasks window looks like this:

The Database Tasks window allows you to open or to create a database.  The first time you run The
Breeder’s Standard® 2022, you must click to create a new database.  This database is stored in a file
with the “.ptped” extension.



11 The Breeder’s Standard® 2022 User’s Manual Getting Started

If you click to create a database, the program will open a Save-As Dialog to ask you for the name of the
.ptped file to create, and where to create the file.  It takes about 10-20 seconds to create the database
file on an average computer.

If you click on open a database, you will receive an open window that will allow you to select an
existing .ptped file, which contains the databases for The Breeder’s Standard® 2022, or iPed 5G or later,
or CompuPed® 5G or later.

If you click to create a database, the program will ask you the name of the .ptped file to create, and
where to create the file.  It takes about 10-20 seconds to create the database file on an average
computer.

Note for Windows users: Do not place the file in the root directory of the C: Drive or in any
folder in the Program Files or Program Files (x86) folders. PedFast Technologies recommends
that you place the .ptped file in your Documents folder or in folder inside your documents
folder.

Help Me Find my Database

If you click on “Help me Find my Database,” The Breeder’s Standard® 2022 will search every drive on
your computer for .ptped files that may exist on the computer.  This may take some time if your
computer has large or slow drives on it.  When it has completed looking, it will let you know if any files
were found.  If so, the program will pop up a window with all of the .ptped files listed, with sizes and
dates.  This is useful if you accidentally create a second database file and need to find an older and
larger one.

The Found Databases window looks like this:

When you have the Found Databases Window, you just click on the database file you want to open, and
the program will open up that database for you at once.



12 The Breeder’s Standard® 2022 User’s Manual Getting Started

The Look and Feel of the Program
This is the main window of The Breeder’s Standard® 2022:

The Breeder’s Standard® 2022 is designed along the lines of Microsoft Office.  Each window is designed
in two halves, and commands are shown, along with status information, in the right dark pane.  Things
you can do for the entire database are shown in the Kennel Tab.  Things you can do to dogs are shown
in the Dogs tab.  The Contacts tab contains what you can do with Contacts.

Clicking a tab brings up the work with window for a record type.  This is a searchable list of records,
which is used as the starting point for your work with those records.

The File Menu

The File menu button houses the program’s main menu.  Click this button to change the active database
or to create a new database.  You can also access Program Activation from this menu, shut down The
Breeder’s Standard® 2022, or see the program’s About box.

Shortcut Keys
The Breeder’s Standard® 2022 is equipped with several shortcut keys.  Here’s a list:

F3 Exit the Breeder’s Standard®

2022.  Closes the program and
does not save the work on the
last window you were working
in.
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Ctrl+Shift+H Go to the Home Page of the
program.

The Navigation Bar

The Breeder’s Standard® 2022 is equipped with a navigation bar that shows you the previous several
functions that you visited in the program.  You can navigate backward or forward.  The button at the far
right of the navigation bar permits you to refresh the window without saving any changes you typed in.

The Back button, with the left-pointing arrow, goes to the previous place you visited.  If there has been
no such place, the button is greyed out and does not function.

The forward button, with the right pointing arrow, allows you to progress forward.  If you have not
used the left-arrow button or are at the end of the list, this button will be greyed out and will not
function.

The list button, with three dots, will present a list of the last several places you have visited in the
program.  Clicking an entry on the list brings you to that place in the program.

Using navigation button or link without saving your work in screen that allows you to change
things will cause that work to be lost.

Field Chooser
Most Edit windows in The Breeder’s Standard® 2022 have a field chooser button.  The Field Chooser
button lets you choose to hide entry fields that you don’t use in order to make it simpler for you to
enter data.  You will see the field chooser button to the top-right of the window, above the Options box
with the save link:
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When you click the Field Chooser button, you will be presented with a pop-up box with all of the fields
that you can hide.

The Field Chooser Pop-Up box looks like this:

Every field with a check box will be shown to you in the edit window.  If you remove the check box, you
will hide the field. Required fields cannot be hidden, and you won’t be given the option to hide them .

Choose the fields to hide or keep and click save.  You will see the edit window with the fields you want
hidden no longer visible.

Reports
The Kennel and each record type tab contains a drop down with the applicable reports and a button to
preview the report.

The Report preview window looks like this:
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The Report Preview window permits you to navigate through the pages of the report.  There is a page
navigation strip on the left of the window.  There is also a tool bar.  The tool bar has many options:

Expand: This button will expand or contract the
toolbar into an Office-type task bar for reports.
It is on the far right of the preview window
toolbar.

When you choose to expand, you see this toolbar:

The icons and descriptions may appear differently if you have a
smaller monitor or screen.

Switch between page and continuous view.

Save PDF file with the report in it.  The
Breeder’s Standard 2022 supports PDF exports
of your reports.  No PDF driver is needed.

Page Setup.  Lets you adjust the paper size, the
margins, and orientation.  This will affect how
many pages the report renders onto, within
limits.

Print. Sends this report to the printer to be put
onto paper.  Uses your default printer, but you
can choose other printers.
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Zoom tool. Use the drop down to choose a tool
to zoom in or out.

First Page.  Jump to the first page of the report.

Previous Page.  Go back one page.  This is
greyed out and does not work on page 1 of the
report.

Page Place.  Shows what page is displayed.
Shows total pages in the report.  You can type in
a page number to jump to that page.

Next Page. Go forward one page.  This is greyed
out and will not work if the past page of the
report is displayed.

Last Page.  Jump to the last page of the report.

Hand Tool.  Set your mouse pointer into a
“hand” that grabs a page and moves it up and
down.

Text Select Tool.  Select part of the text in a
report and copy and paste it.

Search.  Activate the search pane.
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Searching report with the Report Search Pane

When you click the  button in a report preview window, you choose to start the search pane.  This is
extremely useful in searching large reports.

The Report Search Pane has these controls:
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You type in the phrase or character’s you want to search for, and the search pane shows all occurrences
of the search string in the pane when you click the Search button.  You can choose to search up, match
character case, and only select whole words that match, or any combination.

Double clicking on a found search term scrolls the report to that term, and highlights the term.

Clicking the Hide button hides the search pane.

The Home Page
When you start up The Breeder’s Standard® 2022, and you have opened a database, you will receive the
Home Page.  This is the starting point for using The Breeder’s Standard® 2022.

The Home Page looks like this:

You will see a summary of the kennel information for the program, and a calendar on the left.  Days in
bold face are those with calendar appointments or reminders; clicking on a day will result in going to
the reminders for that day.

You also have five major buttons that will go to the main window for each tab.  Click on any of those
buttons to go to the appropriate window.

The party in whose name the program has been activated will be displayed below the calendar.  If the
program is not activated, the message will tell you how many days remain before the program must be
activated to continue to operate.

Typing Ctrl+Shift+H from anywhere in the Breeder’s Standard® 2022 will take you to the home page.

Entering and Manipulating Data
There are several different controls in The Breeder’s Standard® 2022, which are all designed to make it
easy for you to enter specific types of data.  Here are a few:

Lookup Control
A Lookup control is used to look up data that is stored in the database and needs to be linked at a
certain place.  An example is the Breed field when you add a dog to the database.
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As you type in each character of the item you are looking up, the control below shows what options you
have.  Pressing an up or down arrow will pick a certain option and fill in the rest of the lookup control.
Or, type the characters and finish your lookup.  Pressing TAB or ENTER will register your choice.

If the lookup control allows it, in certain places you can choose to add a new record to the database.
For example, if you type in a breed that is not in the database, the program will show you the control,
tell you that you are adding a new breed (or contact or whatever is in that space).

If you accept that entry with TAB or ENTER, the program will pop up and ask you if you want to add a
new record to the database, and take you to a form that will quickly add the information for you.

If you choose “Yes,” you can add the record rapidly.  If you choose “No,” your entry will be abandoned
and you will need to retype an entry.

Calendar Control
When you have need of choosing a date, The Breeder’s Standard® 2022 will give you a calendar control.
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Clicking a date chooses it, and you can use the arrow buttons to move back and forth in the calendar.
The clear button empties out the field, and the today button sets to today’s date.

The Web Browser Window
For certain web activities The Breeder’s Standard® 2022 has a built-in web browser.  This will only
display pages fed to it by the program, and linked pages.

The Web Browser window looks like this:

You have some option buttons:

Left Arrow: Back one page

Right Arrow: Forward one page

Reload: Reload the web page

Print: Print the Web Page.

Click the Close link to close the browser and go Home.

The About Window
Clicking the File Menu Button and choosing “About TBS 2022” brings up the About Window.

The About Window looks like this:
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This window contains:

The complete program version number

Copyright notice

A link to the PedFast Technologies Home Page.

You can click a Tab or the Home button on the Navigation Bar to go elsewhere in the program.

Themes
The Breeder’s Standard™ 2022 gives you the ability to select from fifteen themes.  Themes control the
colors of the screens and fonts in the program (MegaPed is not themable at this time).  At the lower
right of the main window, there is a drop down to choose a theme:

When you choose a theme, the windows on screen change immediately to match your choice.  The
Breeder’s Standard™ 2022 remembers the choice you make every time you run the program until you
make a new choice.

The Home page with the default theme looks like this:
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The Home Page with the “Shiny Blue” theme looks like this:

The program ships with fifteen pre-set visual themes.

The Home Page
When you start up The Breeder’s Standard™ 2022, and you have opened a database, you will receive
the Home Page.  This is the starting point for using The Breeder’s Standard™ 2022.

The Home Page looks like this:
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You will see a summary of the Breeder information for the program, and a calendar on the left.  Days in
bold face are those with calendar appointments or reminders; clicking on a day will result in going to
the reminders for that day.

You also have five major buttons that will go to the main window for each tab.  Click on any of those
buttons to go to the appropriate window.

The party in whose name the program has been activated will be displayed below the calendar.  If the
program is not activated, the message will tell you how many days remain before the program must be
activated to continue to operate.

Typing Ctrl+Shift+H from anywhere in The Breeder’s Standard™ 2022 will take you to the home page.
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The Dogs Tab

Work with My Animals
Whenever you click the Dogs Tab, you will receive the Work with My Animals window.  This window
features a list of dogs in the program.  You also have a means to rapidly move through the list, as well as
links to add, change or delete dog records in the database.

Work with Animals looks like this:

Clicking or using the arrow keys to scroll up and down through the list will change the current dog in
the list that is selected.  You can then choose to edit the dog record you selected from the right side
command list, or you can click on any button on the Dogs tab in the “Work With” group in order to
choose a function to perform on the dog.

To add a dog to the database, click on the Create Dog link on the right hand side of the window.

To delete a dog, you click on the Remove Selected Dog link on the right hand side of the window.

The Dog Facts pop-up

As you select dogs, you may see a pop-up window on the right hand side.  This window contains facts
about the highlighted dog.  These facts include:

Titled Name

Sire and Dam names
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How many first-generation descendants of this animal appear in the database.

Photo if present

A LINK to the dog’s OFA information page, if The Breeder’s Standard has its OFA record ID (not
OFA Number) in its database.

A red highlighted warning if there are one or more dogs with identical case-and-possessive-
ignorant registered names on the database.

An orange highlighted warning if there are one or more dogs with similar-sounding registered
names on the database.

The Dog Facts popup looks like this:

The information contained in the window changes as you change the selected animal.

Dog Information
The Dog Information window is where you add or change the basic information for an individual dog.

The Dog Information window looks like this:

As with all windows in The Breeder’s Standard® 2022, the required fields have underlined descriptions.
In the case of this window, Registered name, Breed, Gender, Altered flag and Status.
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You have the following fields to work with:

Reg. Name:  This is the registered name of the dog, excluding titles.  Enter the name, up to 75
characters here.

Breed:  This is a lookup control to let you pick the breed of the dog.  If it does not exist in the
database, you will be given the opportunity to add it here.

Variety:  For breeds with varieties, type it in here.  This will be used in show entry forms where
relevant.

Gender:  Choose the dog’s gender.  Type “M” for Male or “F” for female, and this lookup control
will fill in the rest, press TAB to go on to the next field.

Altered?:  Type “Y” if this dog has been spayed or neutered.  Type “N” if this dog has not been
spayed or neutered.  Press TAB to go on to the next field.

Status:  This displays the status of the dog.  The status is used to determine which dogs print on
the breeding reports, and which dogs are visible in Work with Dogs, depending on the window
settings.

Reg. Number:  This is the primary registration number for the dog.  The Breeder’s Standard ®

2022 can handle 25 characters including spaces.  Lowercase letters are automatically rendered
in capital letters.

Primary Registry:  This lookup control will allow you to look up the Primary Registry of the
dog, the registry with which the registration number is associated.  The registry must exist in
the database already.  If you need to add a registry, please first go to the Utility Tab, click
Registries, and choose to add a registry.

Limited Reg.?:  Type Y if this is a limited Registration, N if it is not.

Registrations: This is a grid that shows all of the registrations and medical certifications for
this dog.  This only appears if you have chosen this in the Field Chooser to appear, and if you are
changing an existing animal.  It’s the same information that you would work with in the
Registrations window.  The Breeder’s Standard® 2022 also provides it here to make it easier to
enter information for a dog.

Coat Color:  Type in the dog’s coat coloration.

Sire:  This is the name of the dog’s sire.  This is a lookup control.  If you type in a new name,
you’ll have the option to quick-add the name to the dog database.

Dam:  This is the name of the dog’s dam.  This is a lookup control.  If you type in a new name,
you’ll have the option to quick-add the name to the dog database.

Call Name:  Use this field for a call name or nickname.

Owners, Etc.:  This is a grid that shows all of the owners, breeders, and people from whom this
dog was obtained.  This only appears if you have chosen this in the Field Chooser to appear, and
if you are changing an existing animal.  It’s the same information that you would work with in
the Owners, Etc. window.  The Breeder’s Standard® 2022 also provides it here to make it easier
to enter information for a dog.

Size:  This is a free form field for entering generalized information about the size of the animal,
for example, a Giant Schnauzer vs. a Standard Schnauzer.
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Born:  Date of Birth.  Unlike previous versions of this program, approximate or circa dates are
allowed.

Died:  Date of Death.  Unlike previous versions of this program, approximate or circa dates are
allowed.

Height: Type in the dog’s height at the withers.

Weight: Type in the dog’s weight as measured in your country.

Jump Height: Type in the dog’s Jump height for agility, if applicable.

Eye Color:  Type in the dog’s eye coloration.

DNA Profile #1: This is one of two possible DNA profile codes for this dog.

DNA Profile #2: This is one of two possible DNA profile codes for this dog.

Tag/Tattoo:  This is the Tag or Tattoo identification for this dog.

COI: This is the Sewall Wright Coefficient of Inbreeding for this dog.  You can enter any number
less than or equal to 1.0, or you can press the “Calc” button to the right to calculate the COI for
this dog, up to 10 generations. The Breeder’s Standard® 2022 will calculate this coefficient for
up to 10 generations.

Stud Book:  This is the month and year this dog was published in the Stud Book of its primary
registry.

Chip Number:  If your dog has an embedded chip, enter its number here.

Comment:  Enter a free form comment of up to any length here for internal reference.  This
comment is not available on reports and may be treated confidentially.

You can use the Field Chooser to choose to work with fewer than all of the fields listed here.

Click the Save link to save the information you have entered.

Click the Save this record and add another link to save this record and to begin a new record in add
mode.

Click the Close link to close this window without changing any data.

Extra Fields
The Breeder’s Standard® 2022 gives you the power to create as many extra fields for an animal as you
desire.  To make changes to those Extra Fields, you can simply:

Select the animal from My Dogs and click Extra Fields

Right click the animal from My Dogs and click Extra Fields

Click Extra Fields from any dog related window that is open.

The Animal Extra Fields window looks like this:
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All of the fields in the window are what you define them in the Utility Tab, Extra Field Types window.

Once you have entered the information you want, click the Save link to save the data to the animal and
you are done.

To close without changing, click the close link.

Owners, Etc.
Animals can have one or many contacts linked to them as Breeders, Owners, or obtained-from parties
(e.g., someone who sold the animal to its present owner).  The Owners, Etc. window is where those
changes are made.  To make changes to those related contacts, you can simply:

Select the animal from My Dogs and click Owners, Etc.

Right click the animal from My Dogs and click Owners, Etc.

Click Owners, Etc. from any dog related window that is open.

The Owners, Etc. for an animal looks like this:

You can choose to do any of the following:
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Add a contact to the animal

Change a contact for an animal

Delete a contact from an animal.

To change or delete you must have clicked the animal’s related contact that you wish to change or
delete beforehand.

Add/Change Animal Contact

When you click to add or change a contact for an animal, the Add/Change Animal Contact window pops
up.  You can use this window link a contact to the animal for a certain role.

The Add/Change Contact pop-up looks like this:

You have these fields:

Person:  This is a lookup control to find or add a contact.

Type:  This is the role that this contact has to the animal.  The available roles are:

o Owner 1, 2, 3 or 4 – up to four owners per animal

o Breeders 1, 2, 3 or 4 – up to four breeders per animal

o Obtained from 1, 2, 3 or 4 – up to four people from who the animal could be obtained (e.g.,
previous owners).

Note: You can only have one contact of each role, that is you cannot have two people as
Owner 1, etc.

Once you have entered both fields, you can choose to save.  Clicking Cancel will close the pop-up
without saving anything.



30 The Breeder’s Standard® 2022 User’s Manual The Dogs Tab

PedFast™
The Breeder’s Standard® 2022 continues its fine tradition of easy pedigree entry for an animal with
PedFast™ V.  It will look up existing animals, and will also add new animal names.

As you type in each name and press the TAB key, you will start at the top of each Generation and work
your way down, first Sire, then Dam, and so forth.  If you type a name that already exists, the animal’s
ancestors will be filled into the pedigree automatically.

If you type in a new animal’s name, you will hear a beep and The Breeder’s Standard® will add the
animal to the database immediately, using the gender of the space in which you typed the animal’s
name and the breed of the target animal.  Status will be “Pedigree Only.”

PedFast™ V looks like this:

Filling in Ancestors

To enter an ancestor, begin typing the ancestor’s name.  If the name is on the database, you will see it
pop up:

Keep typing until the desired animal appears and press TAB, or click on the desired animal.  At that
point, PedFast™ V will load in any ancestors of the selected animal, and hook the animal into the
pedigree. Unlike previous versions, you no longer need to click save button or link.

Entering New Animal as an Ancestor

If the animal you are entering into the pedigree is not already in the database, PedFast™ V will add the
animal to the database:



31 The Breeder’s Standard® 2022 User’s Manual The Dogs Tab

Type the animal’s full name and press TAB.  The animal will be saved and added as an ancestor (sire or
Dam) to the correct animal in the pedigree, and that animal’s sire and dam boxes will be enabled for
entry.

Removing an Ancestor

If you want to remove an ancestor, just clear out the ancestor’s name from the box and press TAB.  This
will unlink that ancestor from the pedigree and remove it and its ancestors from the screen. Don’t
worry! Removing an ancestor from the pedigree will NOT remove the ancestor’s record from the
database!  It just breaks the Sire or Dam relationship to the ancestor’s descendant.

The Action Menu

When you want to adjust an ancestor, add quick titles, or remove an ancestor (aside from the method
described above, you can right click on the ancestor’s box. Clicking on an empty box will cause beep
and nothing will be done.

Right clicking on an ancestor’s entry box will open the Action Menu:

You can choose three options:

Zoom:  this will open the animal’s Dog Information Window.

Quick Information…:  This will open the quick information pop-up for this animal.  See below
for more information.

Clear This position:  This will remove the ancestor from the pedigree, in the same way that
emptying out the box and pressing TAB will do.

The PedFast™ Quick Information Pop-Up

When you choose Quick information from the action menu for an ancestor, you will receive the quick-
information pop-up.  This allows you to rapidly change frequently-changed fields and to add or remove
titles from the animal.

The Quick Information pop-up looks like this:



32 The Breeder’s Standard® 2022 User’s Manual The Dogs Tab

You can make changes to the animal in the pop-up and click save or close, including quick titles.  This
pop-up works just like the Dog Information Window, including Field Chooser.

Titles
Working with Animal Titles in The Breeder’s Standard® 2022 may be done in the drag-and-drop
environment in the Animal Titles window.  This window allows complete control over the titles given to
an animal, much more than quick titles.

The Animal titles window looks like this:

Manipulating Titles:

On the left list are all unassigned titles.  On the right list are the earned titles.

Click the “Clear All Earned” button to remove all titles from the Earned window.

Click any quick title to add it to the end of the Earned Titles list.
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Dragging titles:

To add titles to an animal, drag from the left list to the right list.  The mouse arrow will turn into a “plus
sign” when over a title, and that is where the program will insert the title.

Drag a title from the right list to the left to remove it from an animal.  You may also drag titles around in
the right window to rearrange them.

As you do, the titled name will change to reflect your changes.

Click the save link to save your changes, or the Close link to close out the Titles window without any
changes being saved and revert to the My Dogs window.

Registrations
You can create any number of registries you want.  For each registry, you can assign each animal a
registration number.  You do that from the Dogs, tab, with the dog selected in My dogs or with any of its
work-with windows opened, and then clicking Registrations.  That will bring up the registrations
window.

The Registrations Window looks like this:

You have the following Links:

Add: This will cause the program to add a new record.

Edit: This will open the change window for the selected record. Double-clicking the left mouse
button will also do the same.

Remove: This will delete the highlighted record from the database, if it is not in use. Otherwise
a message is displayed.

Add/Change Registrations

Add/Change Registrations lets you assign a registration to an animal. It pops up when you choose to
add or change a dog’s registration.

The Add/Change Registrations pop-up looks like this:
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You have the following fields to work with:

Registry:  Type the name of the registry into this lookup control.  If it is new, then you will be
asked to create a new registry record.

Registration Nbr.:  Type in the correct registration number or registration information.

Comment:  A free-form private comment.  This is not printed on the pedigree or any report.

Click Save to save this registration.

Click Close to close the pop-up and abandon all changes.

Photos
The Breeder’s Standard® 2022 supports all popular non-vector graphical formats for the attachment of
one to many pictures to the Dog record. There is no practical limit to the number of photos per animal;
the database can have a total of about 2 billion photos.

The Dog Photo window looks like this:
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You have the following Links:

Add: This will cause the program to add a new record.

Edit: This will open the change window for the selected record. Double-clicking the left mouse
button will also do the same.

Remove: This will delete the highlighted record from the database, if it is not in use. Otherwise
a message is displayed.

Add/Change Animal Photo

When you click to add or change a photo on the dog, a pop-up will appear to collect the photo and other
information.

The Add/Change Animal Photo pop-up looks like this:

You have the following fields to work with:

Use in Pedigrees?:  The first photo entered that has this set to yes will be used in the MegaPed
pedigrees that contain this dog.
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Description: Please describe the photo as you see fit.

Picture:  This is a photo-chooser control.

o Clicking Choose… will bring up a File-Open Dialog that you use to locate and choose the
picture file.

o Clicking Zoom… will toggle between zooming to actual size and fitting the photo into the
space allotted for the control.

o Clicking Clear removes the photo from the control.

Click Save to save this photo.  The photo is copied from the original file and stored into the database.

Click Close to close the pop-up and abandon all changes.

Competition

Work with Competition
When you click the Competition entry in the Work With Group of the Dogs Tab, you will receive the
Work with Competition history page.  This page shows, in chronological order, all of the entry forms
you ordered up plus all of the events that you have tracked in The Breeder’s Standard ® 2022.

The Work with Competition window looks like this:

If you click on the line in the grid representing an entry form, you have an option to print the form
again.  You also have the option to add any of the supported types of competition entries.

The Work with Competition Options box looks like this:
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Click or choose the Shortcut Key (Press ALT + [the underlined letter]) to perform the action you want
on the options list.

Competition: Conformation Event
Conformation Event entries are used to track conformation dog shows for any of the major dog-show
governing bodies.  Judges, placements, and expenses are tracked for each event.

The Conformation event pop-up looks like this:

The Conformation Event window has fields for you to fill in.  They are:

Event Date: The date of the event.

Club Name: The name of the club hosting the event or the name of the event if not hosted by a
club.

Club City: City of event

Club State: State/region/province/prefecture of event.

Entry Fee: Amount paid to enter.

Misc. Expenses: Enter any miscellaneous expenses here for your records.
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Agent: Lookup control to look up or add a Contact who acted as agent or handler for this dog at
this event.

Agent Fee:  Enter how much you paid the agent for services related to this event.

Show Country: This required field is a choice between, USA, Canada, Mexico, UK, Japan, China
or other.

Show Type: This required field is a choice between All-Breed, Specialty, Match, Invitational or
Sweepstakes.

Level: Choose Classes, Specials or Veterans.

Class Judge: Lookup control to look up or add a Contact who acted Class Judge for this dog at
this event.

Class Result: Choose the result.

Class Name:  Type in the name of the class in which this dog competed.

Winners Judge: Lookup control to look up or add a Contact who acted Winners Judge for this
dog at this event.

Winners Result: Choose the result.

Breed Judge: Lookup control to look up or add a Contact who acted Breed Judge for this dog at
this event.

Breed Result: Choose the result.

Group Judge: Lookup control to look up or add a Contact who acted Group Judge for this dog at
this event.

Group Result: Choose the result.

Best in Show Judge: Lookup control to look up or add a Contact who acted Best in Show Judge
for this dog at this event.

Best in Show Result: Choose the result.

Points:  Enter any Championship points earned.

Dogs Defeated: Enter a count of dogs defeated.

Comment:  Enter a free-form comment.  This is private and does not appear on pedigrees or
reports.

Click Save to save this event.

Click Close to close the pop-up and abandon all changes.

Competition: Obedience Event

The Breeder’s Standard® 2022 stores complete obedience trial outing information, including scores
properly broken down by trial type (Open A, Open B, Utility A, Utility B, Novice).

The Add/Change Obedience window looks like this:
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The Obedience Event window has fields for you to fill in.  They are:

Event Date: The date of the event.

Club Name: The name of the club hosting the event or the name of the event if not hosted by a
club.

Club City: City of event

Club State: State/region/province/prefecture of event.

Entry Fee: Amount paid to enter.

Misc. Expenses: Enter any miscellaneous expenses here for your records.

Agent: Lookup control to look up or add a Contact who acted as agent or handler for this dog at
this event.

Agent Fee:  Enter how much you paid the agent for services related to this event.

Type: Choose form Novice, Utility A/B or Open A/B. The choices you make will determine what
elements are in the SCORING section below. You will see six or seven windows, to enter the
various scores for the components of the total score for this event, when you have this chosen
and the event date filled n.

Entry Size: Type in the number of dogs entered in this trial.

Judge: This is a lookup control, which you use to select or enter the name of the judge.

You will see six or seven windows, to enter the various scores for the components of the total
score for this event.

Comment:  Enter a free-form comment.  This is private and does not appear on pedigrees or
reports.

Click Save to save this event.

Click Close to close the pop-up and abandon all changes.

Competition: Agility Event
The Breeder’s Standard® 2022 stores agility information in a format compliant with AKC and USDAA
regulations.

The Add/Change Agility window looks like this:
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The Agility Event window has fields for you to fill in.  They are:

Event Date: The date of the event.

Club Name: The name of the club hosting the event or the name of the event if not hosted by a
club.

Club City: City of event

Club State: State/region/province/prefecture of event.

Entry Fee: Amount paid to enter.

Misc. Expenses: Enter any miscellaneous expenses here for your records.

Agent: Lookup control to look up or add a Contact who acted as agent or handler for this dog at
this event.

Agent Fee:  Enter how much you paid the agent for services related to this event.

Judge: This is a lookup control, which you use to select or enter the name of the judge.

Level:  Type in the competition level.

Course length: Course length in yards.

Standard course time: Enter the standard course time.

Actual Course time: Enter the actual course time.

Qualified:  Choose yes or no.

Comment:  Enter a free-form comment.  This is private and does not appear on pedigrees or
reports.

Click Save to save this event.  At this point you will get the Deductions box.

Click Close to close the Agility pop-up and abandon all changes since the last save.

Deductions box:  you can then choose to add, change or delete deductions.  When you click to add or
change deductions, a pop-up for deductions shows.

The deductions pop-up looks like this:
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You have the following deduction fields:

Deduction:  The type of deduction

Ded. Points: Points deduction.

Click Save to save the deduction.

Click Close to close the pop-up without saving.

Click Close to close the Agility pop-up and abandon all changes since the last save.

Competition: Working Trial Event
The Breeder’s Standard® 2022 stores Working Trial information for most registries, up to three stakes.
Fifteen stake types are supported.

The Add/Change Working Trial window looks like this:

The Working Trial window has fields for you to fill in.  They are:

Event Date: The date of the event.

Club Name: The name of the club hosting the event or the name of the event if not hosted by a
club.

Club City: City of event

Club State: State/region/province/prefecture of event.

Entry Fee: Amount paid to enter.

Misc. Expenses: Enter any miscellaneous expenses here for your records.
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Agent: Lookup control to look up or add a Contact who acted as agent or handler for this dog at
this event.

Agent Fee:  Enter how much you paid the agent for services related to this event.

Organization: Type the name of the organization sanctioning the event.

Comment:  Enter a free-form comment.  This is private and does not appear on pedigrees or
reports.

Click Save to save this event.  At this point you will get the Stakes box.

Click Close to close the Agility pop-up and abandon all changes since the last save.

Stakes Box: you can then choose to add, change or delete stakes.  When you click to add or change
stakes, a pop-up for stakes shows.

The stakes pop-up looks like this:

You have the following fields:

Stake Type:  Choose the stake type.

Judge:  This is a lookup control where you can choose or add the contact who is judge of this
stake.

Place: Enter placement.

Points: Enter points.

Click Save to save this stake.

Click Close to to close the stake pop-up without saving anything.

Competition: Schutzhund Event

The Breeder’s Standard® 2022 stores Schutzhund trial information on a by-trial basis.

The Add/Change Schutzhund window looks like this:
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The Schutzhund Window has fields for you to fill in.  They are:

Event Date: The date of the event.

Club Name: The name of the club hosting the event or the name of the event if not hosted by a
club.

Club City: City of event

Club State: State/region/province/prefecture of event.

Entry Fee: Amount paid to enter.

Misc. Expenses: Enter any miscellaneous expenses here for your records.

Agent: Lookup control to look up or add a Contact who acted as agent or handler for this dog at
this event.

Agent Fee:  Enter how much you paid the agent for services related to this event.

Level: Choose Schutzhund I, II or III.

Judge: This is a lookup control, which you use to select or enter the contact for the judge.

Scoring: Enter scores for Tracking, Protection and Obedience.

Comment:  Enter a free-form comment.  This is private and does not appear on pedigrees or
reports.

Click Save to save this event and close the window.

Click Close to close the pop-up and abandon all changes since the last save.

Competition: Herding Trial Event
The Breeder’s Standard® 2022 stores Herding trial information on a by-trial basis.

The Add/Change Herding Trial window looks like this:
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The Herding Trial Window has fields for you to fill in.  They are:

Event Date: The date of the event.

Club Name: The name of the club hosting the event or the name of the event if not hosted by a
club.

Club City: City of event

Club State: State/region/province/prefecture of event.

Entry Fee: Amount paid to enter.

Misc. Expenses: Enter any miscellaneous expenses here for your records.

Agent: Lookup control to look up or add a Contact who acted as agent or handler for this dog at
this event.

Agent Fee:  Enter how much you paid the agent for services related to this event.

Course:  Choose Course A or Course B.

Judge: This is a lookup control, which you use to select or enter the contact for the judge.

Trial Level:  Select Trial Level.

Score: Enter a Score

Qualified?:  Choose Yes or No.

Comment:  Enter a free-form comment.  This is private and does not appear on pedigrees or
reports.

Click Save to save this event and close the window.

Click Close to close the pop-up and abandon all changes since the last save.

Competition: Hunt Test Event
The Breeder’s Standard® 2022 stores Hunt Test information on a by-trial basis.

The Add/Change Hunt Test window looks like this:
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The Hunt Test Window has fields for you to fill in.  They are:

Event Date: The date of the event.

Club Name: The name of the club hosting the event or the name of the event if not hosted by a
club.

Club City: City of event

Club State: State/region/province/prefecture of event.

Entry Fee: Amount paid to enter.

Misc. Expenses: Enter any miscellaneous expenses here for your records.

Agent: Lookup control to look up or add a Contact who acted as agent or handler for this dog at
this event.

Agent Fee:  Enter how much you paid the agent for services related to this event.

Judge: This is a lookup control, which you use to select or enter the contact for the judge.

Level:  Choose Junior, Senior or Master.

Hunting Score:  Enter the hunting score.

Bird Finding:  Enter the Bird Finding score.

Pointing: Enter the pointing score.

Trainability:  Enter the trainability score.

Retrieving (Sr/Mast):  For senior or master, enter retrieving score.

Honoring (Sr/Mast): For senior or master, enter honoring score.

Comment:  Enter a free-form comment.  This is private and does not appear on pedigrees or
reports.

Click Save to save this event and close the window.

Click Close to close the pop-up and abandon all changes since the last save.

Competition: Lure Coursing Event

The Breeder’s Standard® 2022 stores Lure Coursing information on a by-trial basis.

The Add/Change Lure Coursing window looks like this:
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The Lure Coursing Window has fields for you to fill in.  They are:

Event Date: The date of the event.

Club Name: The name of the club hosting the event or the name of the event if not hosted by a
club.

Club City: City of event

Club State: State/region/province/prefecture of event.

Entry Fee: Amount paid to enter.

Misc. Expenses: Enter any miscellaneous expenses here for your records.

Agent: Lookup control to look up or add a Contact who acted as agent or handler for this dog at
this event.

Agent Fee:  Enter how much you paid the agent for services related to this event.

Judge: This is a lookup control, which you use to select or enter the contact for the judge.

Speed Score: Enter the Speed Score.

Agility Score: Enter Agility Score.

Endurance Score: Enter the Endurance Score.

Overall Ability:  Enter the Overall Ability Score.

Follow Score:  Enter the Follow Score.

Points:  Enter the points earned.

Comment:  Enter a free-form comment.  This is private and does not appear on pedigrees or
reports.

Click Save to save this event and close the window.

Click Close to close the pop-up and abandon all changes since the last save.

Competition: Rally Event
The Breeder’s Standard® 2022 stores Rally information on a by-trial basis.

The Add/Change Rally window looks like this:
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The Rally Window has fields for you to fill in.  They are:

Event Date: The date of the event.

Club Name: The name of the club hosting the event or the name of the event if not hosted by a
club.

Club City: City of event

Club State: State/region/province/prefecture of event.

Entry Fee: Amount paid to enter.

Misc. Expenses: Enter any miscellaneous expenses here for your records.

Agent: Lookup control to look up or add a Contact who acted as agent or handler for this dog at
this event.

Agent Fee:  Enter how much you paid the agent for services related to this event.

Rally Level:  Choose Novice, Advanced or Excellent.

Judge: This is a lookup control, which you use to select or enter the contact for the judge.

Jump Height:  Enter the Jump Height.

Time:  Enter the elapsed time.

Deductions:  Enter the points total.

Comment:  Enter a free-form comment.  This is private and does not appear on pedigrees or
reports.

Click Save to save this event and close the window.

Click Close to close the pop-up and abandon all changes since the last save.

Competition: Barn Hunt Event
The Breeder’s Standard® 2022 stores Barn Hunt information on a by-trial basis.

The Add/Change Barn Hunt window looks like this:
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The Barn Hunt Window has fields for you to fill in.  They are:

Event Date: The date of the event.

Club Name: The name of the club hosting the event or the name of the event if not hosted by a
club.

Club City: City of event

Club State: State/region/province/prefecture of event.

Entry Fee: Amount paid to enter.

Misc. Expenses: Enter any miscellaneous expenses here for your records.

Agent: Lookup control to look up or add a Contact who acted as agent or handler for this dog at
this event.

Agent Fee:  Enter how much you paid the agent for services related to this event.

Level:  Choose Grand National or Games.

Judge: This is a lookup control, which you use to select or enter the contact for the judge.

Qualified:  Choose yes or no.

Placement: Enter a placement.

Placement Time: Enter a placement time.

Comment:  Enter a free-form comment.  This is private and does not appear on pedigrees or
reports.

Click Save to save this event and close the window.

Click Close to close the pop-up and abandon all changes since the last save.

Competition: Training Log

The Breeder’s Standard® 2022 stores training log entries by date.

The Training Log window looks like this:
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The Training Log Window has fields for you to fill in.  They are:

Event Date: The date of the event.

Training Notes:  Enter a free-form note of any length you choose.

Click Save to save this event and close the window.

Click Close to close the pop-up and abandon all changes since the last save.

AKC Show Entry Form
The AKC Show Entry function takes in information to store and print the AKC Show entry.

The Show Entry window looks like this:

You have the following fields:

Reg. Country:  Country of Registration.

Registration Type:  Choose AKC, ILP or Foreign.

Country of Birth:  Choose the dog’s country of birth for the entry.

Event Date: The date of the event.

Club Name: The name of the club hosting the event or the name of the event if not hosted by a
club.

Club City: City of event

Club State: State/region/province/prefecture of event.

Entry Fee: Amount paid to enter.

Misc. Expenses: Enter any miscellaneous expenses here for your records.
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Agent: Lookup control to look up or add a Contact who acted as agent or handler for this dog at
this event.

Agent Fee:  Enter how much you paid the agent for services related to this event.

Show Class:  Type in show class.

Division:  Type in Division.

Obedience Class:  Type in Obedience Class.

Rally Class: Type in Rally Class.

Jr. Show Class:  Type in the junior showmanship class.

New Exhibitor?: Choose Yes or No.

Owner-Handler?: Choose Yes or No.

Email?: Enter email address.

Junior Handler:  Type in the Junior Handler name.

Junior Handler DOB:  Type in the Junior Handler Date of Birth.

Junior Handler Rel. Dog:  Type in the Junior Handler’s relationship to the dog.

Comment:  Enter a free-form comment.  This is private and does not appear on pedigrees or
reports.

Click Save to save this event and bring up the preview window of the Show Entry.

Click Close to close the pop-up and abandon all changes since the last save.

Show Entry Preview

After you save the Show Entry information, you receive a print preview window with the entry.  It is a
Reports window.

The Show Entry Preview window looks like this:

You can choose to print it or save to a PDF file.
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Profile
There is a profile report that is a dossier of a dog, which can be used to produce a promotional flyer for
any dog.  It contains a photo and a long-form rich-text description.

The Dog Profile window looks like this:

You have the following fields:

Profile Text:  Type in a long form rich text description of the animal.

Show Vet Visit History?:  Choose yes to show the dog’s vet visits on the profile report.

Show Vaccine History?:  Choose yes to show the dog’s vaccinations on the profile report.

Show Traits List:  Choose yes to show the dog’s trait list on the profile report.

Picture to show:  Choose the picture of the dog you’d like to show on the profile report.

Click Save to save the dog’s profile information.

Click Close to close the dog’s profile without saving it.

Duplicate Finder
The DataSifter™ component present in the previous three versions of The Breeder’s Standard has been
replaced with an all-new Duplicate Finder.  It makes use of our innovative technology,
COMPOUNDEX™.

The Duplicate Finder is now invoked at the dog level.  After selecting any dog in Work with My Animals,
you can click the Dup. Finder button on the Dogs Tab, Work With group.  This will immediately search
the database to render all duplicate and potential duplicate dogs into a work-with like window.

You will see the dog itself labeled as “Target,” along with exact matches and “sounds like”
COMPOUNDEX matches shown.

The Duplicate Finder window looks like this:
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You may select a single animal and click the “delete” button to delete that animal completely from the
database.  Or, you may choose animals to merge by clicking on the check boxes of the animals to keep
and merge, and then clicking the Merge into Selected Dog link.  Then, The Breeder’s Standard will
merge the duplicates into the dog.

When you are completed, you can use the back button to go back where you came or the close link to
close out the dog record.

Relatives
The Work with Dog Relatives page permits you to see related animals to the selected dog.  To activate
work with Relatives, select a dog on the Work with My Animals page.

You can choose to see four different kinds of information about a dog:

Progeny:  The first generation descendants of the selected dog.

Sire Siblings: Dogs that share the same Sire (but maybe not the same Dam) as the selected dog.

Dam Siblings: Dogs that share the same Dam (but maybe not the same Sire) as the selected
dog.

Full Siblings: Dogs that share the same Sire and Dam as the selected dog.

The Work With Relatives page looks like this:
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You can select a dog and zoom into its Dog Information window in order to edit the information or
make other changes, or to see a pedigree.

You can also Use the back button to go back where you came, or you can click the close link to close out
the Dog Relatives window and go back to the Work with My Animals window.

Heats
The Work with Dog Heats page permits you to see related animals to the selected dog.

The Work with Heats window looks like this:

You have the following Links:

Add: This will cause the program to add a new record.

Edit: This will open the change window for the selected record. Double-clicking the left mouse
button will also do the same.

Remove: This will delete the highlighted record from the database, if it is not in use. Otherwise
a message is displayed.
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Add/Change Animal Heat

When you add or change a heat record, you receive the Heats pop-up window.

The Heats pop-up window looks like this:

You have the following fields:

Start Date:  Enter the start date of the heat.

Fertile Date:  Enter the fertile date of the heat.

End Date:  Enter the end date of the heat.

Comment:  Enter a free-form comment.  This is private and does not appear on pedigrees or
reports.

Click Save to save this event and close the window.

Click Close to close the pop-up and abandon all changes since the last save.

Matings
The Breeder’s Standard® 2022 stores mating information for each animal, showing date mated, animal
mated to, its owner and the person who supervised the mating. This information is ordered by mating
date.

The Work with Matings page looks like this:
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You have the following Links:

Add: This will cause the program to add a new record.

Edit: This will open the change window for the selected record. Double-clicking the left mouse
button will also do the same.

Remove: This will delete the highlighted record from the database, if it is not in use. Otherwise
a message is displayed.

Add/Change Mating

The Breeder’s Standard® 2022 enables you to store a virtually unlimited matings per dog. Both the dog
and its mate must be on the database of this kennel. Adding the record of mating to either of the mating
pair automatically records it for both animals, thus saving you the tiresome effort of duplicate entries.
So, you can enter matings for just the dams and the sire’s mating record will automatically be correctly
reflected.

The Add/Change mating window looks like this:
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You have the following fields to work with:

Date: The date that this mating happened.

Mated To: This is a lookup control to find the dog that you have mated your animal to. It must
exist in the database in order to use it. You must choose a mate dog with owner information in it
or the program will not allow the dog to be used as a mate.

Mated by and Mated by 2: These fields are lookup controls for the contact that served as each
of mated by 1 and 2. Choose the person(s) who supervised the mating of these animals. If they
are not on the database, you may add them from here.

Comment:  Enter a free-form comment.  This is private and does not appear on pedigrees or
reports.

Click Save to save this event and bring up the preview window of the Show Entry.

Click Close to close the pop-up and abandon all changes since the last save.

When the Mating is connected to a litter, you also have these links:

Go to Mating’s Litter:  Clicking this link will open the litter for this mating, if you created the
litter from this mating.  The mating will close (without saving any changes made since the last
save) and the Litter Information Page for the linked litter will open.

Detach Litter from Mating: Clicking this link will permanently break the link between litter
and mating.

When the mating is not connected to a litter, you are given this link on existing matings:

Create Litter from Mating:  Clicking this link will take the mating information from this record
and create a new litter record and link them together.  You can then choose to go to the litter, in
which case the mating will close (without saving any changes made since the last save) and the
Litter Information Page for the linked litter will open. If no, you will remain in the mating
record, but you will have the options to go to the litter or detach available to you.

Creating mating on the other animal:  When you save the mating for the first time, the program will
ask you if it should creating the mating for the other animal in the mating as well.  IF you choose yes,
the information will be completely copied from the mating you have just entered, but that will have the
animal and the mated-to animal swapped.  So if you mated Harry and Sally, and entered the mating to
Sally, the exact same mating will also be put on Harry’s mating history.

Transactions
The Breeder’s Standard® 2022 will store detailed financial transactions for each dog, both for money
taken in and money spent. You can record these transactions using transaction types, which let you
review transactions by what kind of transaction took place.

The Work with Transactions page looks like this:
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You have the following Links:

Add: This will cause the program to add a new record.

Edit: This will open the change window for the selected record. Double-clicking the left mouse
button will also do the same.

Remove: This will delete the highlighted record from the database, if it is not in use. Otherwise
a message is displayed.

Add/Change Transaction

The Breeder’s Standard® 2022 enables you to store up to over one million transactions per dog. These
transactions can have different types, and can track cash both spent and received for the dog. In
addition, you can define Contract text and use these contracts, and can also create a uniform generic Bill
of Sale for any transaction. These things are accomplished from the Add/Change Transaction window.

The Add/Change Transaction window looks like this:

You have the following fields to work with:
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Date: This is the date that the transaction took place.

Tran. Type: This is a lookup control which lists all of the transaction types in the database. If
you type in something not already on the database, then The Breeder’s Standard prompts you
to add what you typed into the database.

Other Party: This is a lookup control for the contact for the other party to this transaction. If
you type in a name not already on the database, The Breeder’s Standard will prompt you to add
it.

Delivery Dates (if applicable): Delivery dates are important AKC-required fields. It is from
this set of fields that the AKC report (Ownership Information for a Dog) gets its required
information. Other registries have similar requirements. The fields are:

o Reg. App/Cert: Enter the date that you delivered the Registration Application or certificate
to the other party.

o Bill of Sale: Enter the date that you delivered the Bill of Sale or other transfer document to
the other party.

o Contract: Enter the date that you delivered the contract to the other party.

Contract: Choose the type of contract covering this transaction, if applicable.

Amt. Paid: Amount you paid out in this transaction.

Amt. Received:  Amount you received in this transaction.

Comment:  Enter a free-form comment.  This is private and does not appear on pedigrees or
reports.

Click Save to save this event and bring up the preview window of the Show Entry.

Click Close to close the pop-up and abandon all changes since the last save.

Contract and Bill of Sale

When you are working with an existing transaction (you must save it first), and the Transaction Type
Activity is set to Sell, you will have the ability to create a Bill of Sale or a Contract for that transaction.
When the transaction is eligible, you will see these links:

If you click to create a Bill of Sale, the program will fetch the transaction and start up the Report
Preview Window with a Bill of Sale.

The Bill of Sale Preview window looks like this:



59 The Breeder’s Standard® 2022 User’s Manual The Dogs Tab

When you choose to create a contract, the program will fetch the transaction (you need to have selected
a contract type or the contract will be blank – nothing at all), and will start up the Report Preview
window with a Contract.

The Contract Preview window looks like this:

Helpful Contract and Bill of Sale Hints:

Make sure that your Kennel Information is fully filled out with your name, address, and phone
or email, so that it will appear in the contract and Bill of Sale.

Ensure that the other party’s contact information is also fully filled out, so that it will appear on
the contract.

Remember that you should have a licensed attorney draft your contract language!  We don’t
give legal advice, and the license agreement has a warning:

o “You are notified that any Bill of Sale or Contract produced by this software are not
guaranteed to meet the legal requirements of your locality, or the requirements of any
governmental agency, or the requirements of any kennel club, and expressly hold Company
harmless for their use.

o “You understand that contract text is not provided to you, and that you are expected to
retain the services of a licensed attorney in your locality to draft contract language suitable
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to your needs.  You, in any event, acknowledge that Company has no liability in any
circumstance with respect to the use or enforceability or legality of any Contract or Bill of
Sale produced by the Software.”

Vaccinations
The Breeder’s Standard® 2022 will store a detailed vaccination history for each dog.

The Work with Vaccinations page looks like this:

You have the following Links:

Add: This will cause the program to add a new record.

Edit: This will open the change window for the selected record. Double-clicking the left mouse
button will also do the same.

Remove: This will delete the highlighted record from the database, if it is not in use. Otherwise
a message is displayed.

Add/Change Vaccination

When you Click Add or Change, you will get the Vaccination Pop-up window. You then can enter or
change information for that vaccination.

The Vaccination Pop-up looks like this:
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You have the following fields to work with:

Vaccine Given: This is a lookup control to choose or create the type of vaccine given.

Date: Enter the date administered.

Administered by:  This is a lookup control for the contact of the person who administered the
vaccination.

Vacc. Cost: The cost to you for this vaccination.

Comment:  Enter a free-form comment.  This is private and does not appear on pedigrees or
reports.

Click Save to save this event and bring up the preview window of the Show Entry.

Click Close to close the pop-up and abandon all changes since the last save.

Veterinary Visits
The Veterinary Visits (formerly: Medical History) data grid shows you the veterinary visits and other
medical history items in date order for this dog.

The Veterinary Visits window looks like this:
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You have the following Links:

Add: This will cause the program to add a new record.

Edit: This will open the change window for the selected record. Double-clicking the left mouse
button will also do the same.

Remove: This will delete the highlighted record from the database, if it is not in use. Otherwise
a message is displayed.

Veterinary History Entry Pop-Up

This window is used to add or change Vet visit information for one sppointment for this dog.

The Vet History pop-up looks like this:

You have the following fields to work with:

Vet. Visited: This is a lookup control. If you visited a vet, you can type in his/her name here. If
the name is not on the database, you will be given the chance to add it.
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Date: The date that this service was rendered.

Service: This is a lookup control which will enable you to choose a vet service which was
performed on this occasion. If you type in a service description which is not on the database,
you will be given the chance to add it.

Next Appt.: Return visit information is used to create an automatic reminder for a future vet
visit. You have up to 255 characters for the reason, and this text will be placed into the
reminder and be dated with the return date, with a 3-day notice lead.

Amt. Paid: How much you spent for the services depicted on this record.

Comments: You have up to 255 characters to make any notations you wish to about this record.

Click on the Save link to save your work.

Click on the Close link to throw away any changes you’ve made and/or to go back to the last saved
version.

Traits
The Breeder’s Standard® 2022 allows you to store traits for a dog and then to analyze the traits instead
of the dogs using Crystal Ball™. When on the dog in My Dogs, or when you are in any of the dogs
windows, click the Traits link on the Dogs tab.

The Animal traits window looks like this:

You have the following Links:

Add: This will cause the program to add a new record.

Edit: This will open the change window for the selected record. Double-clicking the left mouse
button will also do the same.

Remove: This will delete the highlighted record from the database, if it is not in use. Otherwise
a message is displayed.

Trait Information Pop-Up
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When you Click Add or Change, you will get the Trait Information Pop-up window. You then can enter
or change information for that vaccination.

The Trait Information Pop-up looks like this:

You have the following fields to work with:

Trait Type: Type in the trait you want to assign to this dog. This is a lookup control. If the trait
you typed in is not on the database, you will be given the chance to add it.

Comments: You have up to 255 characters to make any notations you wish to about this record.

Click on the Save link to save your work.

Click on the Close link to throw away any changes you’ve made and/or to go back to the last saved
version.

Medications
New with The Breeder’s Standard® 2022 is the ability to enter and track prescription and other
mediDogions to your Dogs.  These differ from vaccinations in that these are not intended to prevent
disease, but rather to treat temporary or persistent conditions. When on the Dog in My Dogs, or when
you are in any of the Dogs windows, click the MediDogions link on the Dogs tab.

The Animal Medications window looks like this:
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You have the following Links:

Add: This will cause the program to add a new record.

Edit: This will open the change window for the selected record. Double-clicking the left mouse
button will also do the same.

Remove: This will delete the highlighted record from the database, if it is not in use. Otherwise
a message is displayed.

Add/Change Medication

When you Click Add or Change, you will get the Medication Pop-up window. You then can enter or
change information for that Medication.

The Add/Change Animal Medication Pop-up looks like this:

You have the following fields to work with:
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Medication: This is a lookup control where you can type in the medication and add it to the
medications database if it isn’t there already.

Strength: Strength of the medication.

Frequency: Prescription Frequency

Date: Prescription Date.

Refills: Number of refills on this prescription.

Prescribing Vet: This is a lookup control to associate a contact to this medication as a
prescribing veterinarian.

Pharmacy: This is a lookup control to associate a contact to this medication as the filling
pharmacy.

Cost: Enter a cost for this medication

Comment: Enter an optional free-form comment.

Click on the Save link to save your work.

Click on the Close link to throw away any changes you’ve made and/or to go back to the last saved
version.

Individual Animal Reports
When you right click an animal in My Dogs,  The Breeder’s Standard® 2022 will show the individual
animal reports window.

The Individual Animal Reports window looks like this:

Each report that is available is listed as a link.  Just click the link to preview the report.  When you do,
you will receive the Reports Window with the proper report for that animal.  That is all there is to it!
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HoleFinder™
The HoleFinder™ feature will analyze your pedigree from anywhere from 5 through 12 generations,
and find any missing ancestors.  You receive a list of the ancestors with missing parents, as well as an
interactive map of pedigree “holes” where an ancestor is missing.  You can hover on any map position
to see the animal information and click to enter sire and dam to “fill in” the holes.

The HoleFinder™ window looks like this:

When you choose HoleFinder™ for an animal, you get the above window in blank.  Choose a number of
generations between 5 and 12 and click the Go! button. HoleFinder™ will produce a list of animals
missing ancestors, and the scrollable Pedigree map.

The Pedigree Hole Map

Here is a view of the Hole Map:

The hole map shows dots in a pattern like a pedigree.  Green dots mean that the position is full.  The
Red dots are positions that are empty.

The Hole Map Pop-Up

You can hover your mouse on any dot to see information about the animal.

Here is a full dot’s information:
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Here is an empty dot’s information:

Here is a full dot with one or more missing parents:

You can click on a full dot with one or more missing parents and receive a popup to enter the ancestors.

Quick Parents
When you click on a HoleFinder entry in the list and choose quick parents, or you click on a green Hole
Map that has missing parents (red dots for sire or Dam), you will receive the Quick Parents window.

The Quick Parents window looks like this:
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You have the following fields to work with:

Sire:  This is the name of the dog’s sire.  This is a lookup control.

You can choose an existing name and it will be selected.

If you type in a new name, you’ll be asked if the name should be added to the database.  If you
choose “no,” you will have to re-enter the name.  If yes, the name will be added to the database.

Dam:  This is the name of the dog’s dam.  This is a lookup control.

You can choose an existing name and it will be selected.

If you type in a new name, you’ll be asked if the name should be added to the database.  If you
choose “no,” you will have to re-enter the name.  If yes, the name will be added to the database.

Click OK to add the Sire and the Dam and close the window.  The HoleFinder™ window will reload itself.
Click cancel to close the window without changing the animal’s parents.
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PedCabinet™

PedCabinet™ File Storage Optional Feature

PedCabinet™ is an optional feature that enables you to store files and documents with each animal,
contact or litter in your database as well as the kennel database itself.  When you activate your
program, or when you use PedCabinet for the first time (whichever comes first), you have 14 days to
try the feature out.  After 14 days, you will need to purchase the PedCabinet™ option in order to
continue to use it.

You can drag files from your computer’s disk drive into PedCabinet™ and once they are in, you don’t
need to keep them on the disk drive anymore, because they are now inside your database file.  This
offers you additional security since any files in PedCabinet are automatically backed up along with your
database file.

You select an animal and click the PedCabinet™ button, and you will get the PedCabinet page.

PedCabinet looks like this:

There are a couple of ways to add and work with the files in your PedCabinet™.  There are buttons and
you can also drag and drop files from Windows into the PedCabinet.

PedCabinet’s buttons:
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Add file:  Click this button to add a file to this animal’s PedCabinet.

Delete file: Click one or more files (multiple select by holding down CTRL and clicking
multiple files, and then click this button to remove files from this animal’s PedCabinet.
Note: Once you confirm the deletion, the files are permanently removed from the
PedCabinet and this action cannot be undone.

Preview file:  Click one file and click this to preview the file in the PedCabinet.
Previewing is described in detail later.

Open file: Click one file and click this button to open the file with the program that you
have in Windows to open the type of file that is selected.

Save file:  Click one file and click this button to save the selected file to your computer.
This makes a copy of the file on your computer, but does not delete the file from the
PedCabinet.

Tiled

Shows icon and “tiles” containing information.

Like this:

Large
Icons

Shows Large Icons with names.

Like this:

Small
Icons

Shows Small icons to the left of the description.

Like this:

List

Shows a list of icons and names.

Like this:
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Details

Produce a fully detailed and sortable list.

Like this:

Dragging and Dropping

You can drag one or more files from a Windows Explorer window into the large white area.  You will
then get an add/change information window to add information to each of the dragged file(s) and store
them into your database.

Right Click Menu:

You can right click on any file and receive a context menu.  The right click menu for a file looks like this:

You have the following menu options:

Open: Open the selected document with the program that Windows has for that file.

Preview:  Preview the file using the PedCabinet™ Preview Window.

Change Info: Change the information for the file (but not the file itself) in the PedCabinet™

Delete: Delete the file.

Add or Change File Information
When you choose to add a file to the PedCabinet, either by choosing it with the Add File button or by
dragging files into the PedCabinet, you will be asked for information.

The Add or Change File Information window looks like this:
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You have the following fields:

Description/Note:  Type in a free form description of the file.

File Name: (only appears when adding a single file) This is a file name for the file.  It is filled in
with the file name of the file and can be any valid windows file name (without folders).

Comment:  Enter any free form comment that you want to associate with this file.

Click the Save link to save the file(s) and information into the selected animal’s PedCabinet.  Click the
Close link to close without saving.

The PedCabinet™ Preview Window
PedCabinet™ empowers you to preview its files within the program.  Previews are supported for:

Images

Word Documents

Rich Text (RTF) Files

PDF Documents

Here is a sample preview:
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You can preview a file by clicking to select a file and clicking the preview button, or by right clicking and
choosing Preview.
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Genetics

Crystal Ball™ Genetics
Easily the most important question any breeder asks is “What will be the result if I mate this dog and
this bitch?”  If any person or program could provide an ironclad answer, or even a substantially correct
guess, the person would be rich, or the program’s author would be wealthy and popular.

Crystal Ball™ is our attempt to answer the question.  We provide the breeder with three tools:

One is the “What-If” pedigree.  You choose the dog and the bitch, and print a pedigree for the
proposed mating, now with the full power of MegaPed and all of its layouts.

Another is the inbreeding contribution report, which calculates each ancestor’s genetic
contribution, based on its position in the pedigree and the number of times it appears.

Finally, there is trait analysis.  Divorcing the individual animal from the genetic contribution
and looking at the traits separately, trait analysis is designed to give the breeder an alternative
look at what traits will be passed along to puppies from any prospective mating.

Note: No tool can predict the exact outcome of any mating. We do not represent that the trait
analysis report or any other report generated by The Breeder’s Standard® is able to predict the
kinds of puppies which will come out of any mating. We only supply tool to aid your judgment,
and we accept no responsibility for your use of it.

Crystal Ball™ is located on the Dogs Tab.  Pressing the Crystal Ball button on the tab will bring up its
window.  The Crystal Ball window is not dependent on any dog to run.

The Crystal Ball window looks like this:
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The following controls are present on the Crystal Ball window:

Sire:  This is a lookup control to select a male animal from the database.  You can type in the beginning
of the name to look up.  You cannot add new animals to the database from Crystal Ball™.

Dam:  This is a lookup control to select a female animal from the database.  You can type in the
beginning of the name to look up.  You cannot add new animals to the database from Crystal Ball™.

What to Do:  From this you select one of three options:

“5-Generation What if pedigree”  This option invokes MegaPed, initially with a 5-generation
pedigree.  When in MegaPEd, you can use it with any available pedigree format.

“Inbreeding Report” – This option invokes the Crystal Ball Inbreeding Report, which shows
ancestor genetic contribution. The Inbreeding report will analyze the number of generations
you specify and produce a list of the ancestors in the pedigree, showing the number of times
detected and the percentage of genetic contribution, in reverse order from the most prevalent
ancestor on down.  The results are shown in a print preview window (see Previewing).  The
same functions available to you in print preview are also available in the Crystal Ball windows.

“Trait Analysis” – This option invoked the Crystal Ball™ Trait Analysis Report, which uses the
ancestors’ traits as you assigned them in the Dog Traits Window. The trait analysis report will
use the traits attached to a dog to produce a report like the inbreeding report, but only looking
at the traits assigned to the ancestor dogs.  This report appears in a preview window, and does
not list dogs but rather traits, grouped by dominant, recessive, polygenetic and unknown, and
then by what they affect (type, coloration, etc).

Trait analysis is heavily dependent upon the reliability of the
underlying data.  You have to determine the traits belonging
to as many dogs in the pedigree as you can, and assign them
using the Traits functions on the Dogs tab.

Nbr. Gens:  Select a number of generations from 5 through 10, for use by the Inbreeding Report and/or
Trait analysis.

What-If Ped. Name: Use this field to type in a name for the target animal when generating a what-if
pedigree.  Has no effect on Inbreeding Report or Trait Analysis.

Progress: This window shows the step-by-step progress as Crystal Ball is working. Ten-generation
operations may take some time.
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When you have set your options click the “Run Crystal Ball” link on the right.  From that point, the
Crystal Ball™ module will do its work and present a pedigree or report, as you have selected.

Calculate Wright’s Coefficient
The Breeder’s Standard® 2022 contains a 10-generation calculation mechanism for the Wright
Coefficient of Inbreeding.  Unlike previous versions of this software, the calculator “shows its work.” It
lists all of the ancestor calculation information, enabling you to see how each ancestor figures into the
Wright COI calculation.

To access the calculation for any animal, you can go to the Animal’s information page, and click or touch
the “C.O.I.” button.  You will be presented with the page where the calculation will take place.

The Coefficient of Inbreeding page looks like this:

The page has three selectable options:

Recalculate for Ancestors with Zero Coefficient: Using this option (by placing a check into
the box) will recalculate the Wright coefficient for every ancestor with a zero coefficient.  This
calculation will be done with the available information.  For example, an ancestor in a 10-
generation calculation with a coefficient in the fourth generation can only calculate the
coefficient to six generations.  Even this calculation will, however, result in higher accuracy but
will add to the time needed to calculate the coefficient.

Hide Results until Complete:  The grid containing the list of all of the Ancestors and their
contributions is hidden until completed.  Because the program does not spend time posting up
the results to the screen, time is saved.  For larger calculations.

Number of Generations:  Choose a number between 5 and 16.  The program will use all
generations available up to and including the maximum number chosen.

Click or touch Calc to calculate the coefficient.  When the calculation is done, click or touch the Save
button to save the number into the animal. Click the Close button to close the page and go back to the
My Animals page.

Explaining the Results Window
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The results window has one line for each line connecting a common ancestor between the Sire and the
Dam.  Once a common ancestor is counted once, its direct ancestors are no longer counted.  This is in
accordance with the calculations for the Coefficient of Inbreeding.

You may see one ancestor appear several times as it connects to the corresponding ancestor on the other
side of the pedigree.

The entries you will see for each line are:

Ancestor Name:  The registered name of the ancestor.

Beh, Sire:  The number of generations this occurrence of the ancestor lies behind the animal’s
sire.

Beh. Dam: The number of generations this occurrence of the ancestor lies behind the dam.

Pos. Behind Sire: the Ahnentafel position on the sire’s side of the pedigree for this ancestor.

Pos. Behind Dam: the Ahnentafel position on the dam’s side of the pedigree for this ancestor.

Basic F:  The amount of inbreeding added to the coefficient because of this connection, without
counting the ancestor’s coefficient.  The Coefficient formula is:

…in which Fx and Fa are the coefficients for the individual and the common ancestor,
respectively, and N and N! are the number of generations between the common ancestor and
the sire and dam, respectively.  This number omits the “(1+Fa)” part of the calculation.

Ancestor F: The Coefficient of Inbreeding for the Ancestor.  If you have checked off the
“Recalculate for ancestors” option, the program will recalculate the coefficient to the number of
generations available to it.

Total Contrib:  The total contribution, taking into account the Ancestor F, for this occurrence.

Important Notes

You need to be aware of some critical bits of information.  First of all, it is possible to badly skew the
results and over-report the coefficient of inbreeding by filling in open pedigree slots with “unknown” or
“not recorded” or some other entry.  That will be stored by the program as an animal, and will be
consistently used in the calculations as a common ancestor.

If you want an accurate inbreeding coefficient, you should never use dummy placeholder animals to
indicate an empty pedigree spot. Please leave the spot empty. Moreover, future tools designed to help you
navigate to pedigree holes to fill them in will not function properly, and the Sire Dam indicator in the My
Animals page will not be accurate.

Calculate Relationship Coefficient
The Breeder’s Standard® 2022 calculates the Coefficient of Relationship of a proposed mating between
two animals.  The Coefficient of Relationship is a measure of the degree of consanguinity – the
biological relationship – between two individuals. A coefficient of inbreeding can be calculated for the
resulting offspring of a proposed mating as a measure for the amount of pedigree collapse within that
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individual's genealogy. The term coefficient of relationship was defined by Sewall Wright in 1922, and
was derived from his definition of the coefficient of inbreeding of 1921.

In the program, you choose a proposed Sire and Dam to calculate.

The Coefficient of Relationship window looks like this:

The Coefficient of Relationship Formula:

Where F(a) is the Sire’s Coefficient of inbreeding, F(b) is the Dam’s coefficient of Inbreeding and F(ab)
is the coefficient of inbreeding of any offspring of a mating between the two individuals.

The page has three selectable options:

Recalculate Inbreeding Coefficient for Sire and Dam: Using this option (by placing a check
into the box) will recalculate the Wright coefficient the Sire and Dam.  Because the calculation
depends on both Sire and Dam Inbreeding coefficient, if the program does not have a
relationship coefficient calculated, check this box.

Hide Results until Complete:  The grid containing the list of all of the Ancestors and their
contributions is hidden until completed.  Because the program does not spend time posting up
the results to the screen, time is saved, especially for larger calculations.

Number of Generations:  Choose a number between 5 and 16.  The program will use all
generations available up to and including the maximum number chosen.

Note that the same factors that can skew the Coefficient of Inbreeding can also skew the Coefficient of
relationship.  Avoid the use of “unknown” or “empty” dummy animals in pedigrees.   If you don’t know
an ancestor, please leave that ancestor’s place blank.
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Pedigrees

MegaPed™ 2020 An Introduction
The Breeder’s Standard® 2022 uses PedFast Technologies’ MegaPed printing engine to create
customizable pedigrees.  In order to use MegaPed in the program, you go to the My Animals page, and
double-click / double-touch an animal or click / touch an animal and then click/touch the MegaPed
button on the Animal Info page.  The MegaPed window then appears, and previews the pedigree using
the latest settings.

The MegaPed window looks like this:

MegaPed is a tabbed window, similar to what you will see in Microsoft Office products.

You may go between the tabs, adjusting the look and feel of the pedigree.  Then you can press the
Preview button to see the pedigree.

Once you like what you see, choose the PDF button to print the pedigree into a PDF file, or the Print
button to output the pedigree onto your default printer.

The close button is at the lower right hand corner of the page.

The MegaPed window tabs are explained below:
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The MegaPed™ 2020 Home Tab
The HomeTab comes up- when you first start MegaPed.  There are several groups that give you options.

The Render Group

This group has the buttons in it to:

Preview:  Render the pedigree again in the window, using the settings presently set for
MegaPed.

Print: Render the pedigree using the settings set for MegaPed, to the printer you have attached
to the computer. NOTE: Changing the paper size or the orientation in the printer settings will not
change the layout of the pedigree.

PDF: Render the pedigree using the settings set for MegaPed, to an Adobe® Acrobat® PDF file.
You will be asked for the file name of the PDF file to save. NOTE: Changing the paper size or the
orientation in the printer settings will not change the layout of the pedigree.

The Layout/Format Group

This group allows you to choose a layout and /or change the pedigree format to be used.

What is pedigree layout?

A pedigree layout is a choice of format (see below), fonts, colors, fields, logo, watermarks – everything
needed to render the pedigree as you specify.

When you choose an existing layout, it will set the values for all of these items.  Anything you have set
previously will be erased unless you choose to save a new layout before you change to a different one.

What is Pedigree Format?

The pedigree format is the “blank form” of the pedigree.  The page size, orientation, background, lines,
number of generations, and a base font have been selected.  If you change pedigree format, you can then
adjust the other settings, preview and see what you get.

The program comes with several formats pre-installed.  Coming soon, the Pedigree Power Packs will be
available for this version of MegaPed, and will appear in this list.

The Print Options Group

The print options group lets you turn certain parts of the pedigree on or off.  You have the following
print options that can be switched on or off:

Logo

Watermark

Animal Picture

Ancestor Pictures

Certification

Pedigree Lines

SuperFields™

Click or touch the button so that it looks indented to select to print the option; click or touch the button
so that it does not appear indented to select not to print.
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The Formatting Group

This group has one control that controls how long pedigree lines are handled.  If the line is longer than
the space allotted for it, MegaPed will attempt to get control over it by doing what this control tells it.
You have the following options for when the name is too long:

Use Settings in Format: The pedigree format determines the settings.for long names.

Shrink name to Fit: MegaPed reduces the font size until the name fits into the space that is
provided for the name.

Make name field wider: MegaPed tries to expand the name field to fit the name.  This can
cause names to run together.

Wrap text to next line:  MegaPed tries to wrap the text onto the next line.  This can cause text
to collide with lines 2 and 3.

Let Name be Chopped Off:  MegaPed lets the name get chopped off when the place is filled up.

Note: If Superfields are on, this feature is disabled.

Avoiding weird looking pedigrees:

To avoid weird font sizes, try these strategies:

5. Put only the animal’s Titled name on line 1 (see the Fields Tab).

6. Choose “narrow” fonts if your animal names are long (see the Fonts Tab).

The Help Group

This group has one control:  A check box.

If the check box is checked then the Help pane will appear with help for the active part of MegaPed.  If
the check box is not checked, the help pane will be hidden.

The Fonts Tab
The Fonts tab allows you to choose font face, weight and color for the pedigree elements.  You can also
choose the color of the lines in the pedigree.

Here’s a sample font selection:

Use the drop down to select a font face from the fonts installed into your computer.  MegaPed always
controls the size of the font.
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This is the button you use to choose the font face of the pedigree element.  When you
click this button, you will have a pop-up with a drop-down with all of the fonts in your computer
available.  Choose a single font and click OK.

 Use this button to choose a color for the font or for the pedigree lines.

 Use this button to toggle between regular and bold weight for the Font.

 Use this button to toggle font underlining on and off

 Use this button to choose between regular or italic emphasis for the font.

You can select fonts for:

Headline (the big line at pedigree top)

My Info (your information from My Info page)

Animal Names:  You have two selections here:

o Titled:  Animals with titles

o Untitled: Animals without titles.

Certification: An optional certification paragraph printed at the bottom of the pedigree.

Pedigree lines:  Choose a color for the lines in the pedigree format.

The Fields Tab
The Fields tab is where you set up the fields to print on the pedigree.

The Field Setup Group

Each animal in the pedigree, depending on position, may have 1-3 lines.  You can directly edit the fields
on each line, or drag selected fields from the list onto L1, L2 or L3.

Generally, for the best look on narrower pedigrees, consider just the titled name on line 1.

The SuperFields™ Group

New to MegaPed™ with the 2020 version are SuperFields™  Instead of one to three lines of straight text,
SuperFields use HTML technology to render animal name and supplemental information with much
more control over their appearance.

Without SuperFields:
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With SuperFields:

SuperFields™ control word wrapping, offer a better fit into the pedigree format, and offer an
indentation to make for clearer reading.  Here is the SuperField Group:

You have four check boxes:

Use SuperFields™: If this is checked, MegaPed™ 2020 will employ SuperFields technology to
render the pedigree. The pedigree format may not allow SuperFields to render as expected.
Experiment with font faces and settings, and save what you like as new Layout.

Reduce Lines 2+:  The Line 1 contents will be rendered at the normal font size of the format.
All fields placed into L2 and L3 will be reduced to a different font size. This option will be
disabled unless check box appears in Use SuperFields™.

Indent Lines 2+:  Line 1 contents will not be indented; all contents of Line 2 and Line 3 will be
indented. This option will be disabled unless check box appears in Use SuperFields™.

Last Gen L1 only:  If checked, SuperFields will not add any fields on L2 or L3 to the last
generation, and for the next-to-last generation, it will not add fields placed on L3. This option
will be disabled unless check box appears in Use SuperFields™.

The Certification Group

There are three lines for you to type in any certification information you wish to print onto the
pedigree.  This will or won’t appear based on the Print Options that are set on the Home Tab.

The Other Group
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There is a field for the Title of the pedigree, for what text, if any, you wish to print in front of the target
animal’s name in the title line of the pedigree format.

There is also a check box, “Omit Animal Name from Title,” which will print only the text in the title.  This
can be used to set up a title that is only the kennel name or some other value that does not need the
animal’s name.

After you make any changes here, press the preview button to see the changes in the preview window.
You can do this as often as you want to get the pedigree to look the way that you want it.

The Graphics Tab
This is the tab where graphical additions to the pedigree are controlled.

The Logo Group

You can add logos to the pedigree.  Logos are small graphics, as close to square as possible, that print to
the left of your information in most formats.

You can use the Add Logo button to choose a file (BMP, JPG, PNG) to be your logo. You can click on the
logo you want in the format.  You can also toggle whether or not the logo prints on this pedigree.  The
check box here is the same setting found in the Home tab on the Print Options group.

The Watermark Group

You can add watermarks to the pedigree.  Watermarks are that print faded behind the pedigree
information.  MegaPed supports text watermarks as well as graphical ones.

You can use the Add Watermark button to choose a file (BMP, JPG, PNG) to be your watermark. You can
click on the watermark you want in the format.  You can also toggle whether or not the watermark
prints on this pedigree.  The check box here is the same setting found in the Home tab on the Print
Options group.

For the text watermark, you can type in the text, choose the amount of fade (light, medium or dark) and
the font face, as well as bold, underline or italic.

The Legends Tab
The Legends Tab in MegaPed is used to specify legends that can be printed in the pedigree before and
after certain fields.  For example, if in the Fields Tab, you choose [Date-of-Birth], MegaPed will, if the
field is present on the animal, print any legends you choose.

For example, if the Legends are set like this:

And the animal has a date of birth of 1/15/2000, MegaPed would print DOB: 1/15/2000.
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The Right Legend: You can set up a legend on one or both sides of the field.  For example, you can put “(“
on the Legend Left of the registration number, and “)” on the Legend Right, and MegaPed™ 2020 will
render non-blank registration numbers as “(AA123123/45)” if the number is AA123123/45.

If you uncheck the Show box, Legends won’t be used.  For specific fields, you can also blank out the
legend or key in new legends for any field.

Double-click the box for the field, type or remove the information in the legend, and press Enter.

Text Pedigree
The Breeder’s Standard® 2022 generates a quick text-pedigree for pasting into email or other text files
for easy transmission.  The Text Pedigree function creates a five-generation pedigree and displays it.

To create a text pedigree, select the animal in the My Dogs window and then click the Text Pedigree
icon on the Dogs Tab in the Pedigrees group box.  The text pedigree is then generated and displayed.

The Text Pedigree looks like this:

You can scroll up and down if your screen isn’t large enough to display the text pedigree on one
window.

There are two available options:

Copy to Clipboard: This will take the entire text pedigree and copy it to the Windows
clipboard.  You will

Close this Window: This will close the window and return to My Dogs.

Reverse Pedigree
The Reverse Pedigree creates a list of descendants of the animal going down as far as ten (10)
generations.

You can collapse certain descendants and expand them as needed.
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To create a Reverse pedigree, select the animal in the My Dogs window and then click the Reverse
Pedigree icon on the Dogs Tab in the Pedigrees group box.  The Reverse pedigree is then generated and
displayed.

The Reverse Pedigree looks like this:

You can click to expand all levels or to go to the top of the list.  You can right click on an animal and
choose from the menu to do any of the normal editing options for an animal.
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The Contacts Tab

The My Contacts Page: Overview
Whenever you click the Contacts tab, you will receive the My Contacts page.  This page features a list of
contacts in the program.  Contacts are persons who own, breed, sell or purchase contacts.  You also
have a means to rapidly move through the list, as well as links to add, change or delete contact records
in the database.

The My Contacts page looks like this:

Clicking or using the arrow keys to scroll up and down through the list will change the current contact
in the list that is selected.  You can then choose to edit the contact record you selected from the right
side command list, or you can click any button on the right side of the page to perform the described
action on the contact.

To add a contact to the database, click the Create link on the right hand side of the page.

To delete a contact, you click the delete link on the right hand side of the page.

Add Change Contact Page
The Contact Information Page is where you add or change the basic information for an individual
contact.  You have several fields with which to work, as well as choices of other pages of contact
information.

The Add/Change Contact page looks like this:
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You can click the Field Chooser Button to Choose to hide non-required fields that you do not want to
use.

As with all pages in The Breeder’s Standard® 2020, the required fields have underlined descriptions.  In
the case of this window, only the name is required.

You have the following fields to work with:

Name:  Required This is the name of the contact.

Company Name:  Use this field for a kennel, cattery or business
name.

Address 1:  Address Line 1

Address 2:  Address Line 2

City: City

State/Region:  State or region or prefecture.

Zip/Postal Code: Zip or postal code.

Country: Country

Email Address: Email address of the contact.

Contact URL:  The web site for this contact.

Phone #1: Phone number 1.

Phone #2: Phone number 2.

Type: Choose a contact type from the list or type in a new one to
do a Quick add of the contact type.

Comment:  Enter a free form comment of up to any length here
for internal reference.  This comment is not available on reports
and may be treated confidentially.

Please note that some of the above fields may be hidden if you choose to reduce what you see
using the Field Chooser window.

Click Save to save the contact to the database.
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Click Close to close the page and go back to the My Contacts Page.

Related Animals
The Contacts Tab has a number of Work with windows that show animals related to a specific type of
Contact by the type of Relationship the contact has to the animal.

After selecting the contact, you need only to choose the window by clicking the appropriate icon.  When
you do so, you receive a window listing the animals, if any, and the relationship that the anima has to
the contact.  You have the following options:

Animals Owned by the contact.

Animals Bred by the contact.

Animals Obtained from the contact.

Animals with Competition records where this contact was listed as the handler/agent.

Animals with Medical History where this contact is listed as Veterinarian.

Animals with Transaction History where this contact is the other party in the transaction.
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Animals with Competition records where this contact is listed as a judge.

Puppies sold or given to the contact are listed with this button.

For any animal listed, you can right click on the animal and choose a menu option to access the animal’s
information.
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The Litters Tab

Work with My Litters
The Breeder’s Standard® 2022 has a full-powered litter module included. It keeps all of the information
needed to produce the AKC-required litter-produced-by report.  To access Litters, just click the Litters
tab in the program.

The My Litters window looks like this:

You can choose to:

Create a litter

Edit a selected litter

Delete a litter

Work with the puppies of a selected litter

View a Litter Report

The screen lists the registration number, mating date, Sire Dam, Whelp Date, count of Males and Count
of Females.
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Litter Information
Clicking to create a new litter or to change an existing litter will bring up the Litter Information
window.  This is the window where you can enter individual litters and the puppies in a litter.

The Litter Information Window looks like this:

You have the following fields to enter:

Sire:  This is a lookup control that is used to choose a Sire

Dam:  This is a lookup control that is used to choose a Dam

Mating Date: This is the mating date of the pair

Whelp Date: This is the date that the puppies were whelped

Comment: Enter a free-form comment about the litter.

After filling in the fields above, click save to go on to enter puppies into the Litter.

Entering puppies into the Litter

The program has a grid that holds a listing of the puppies entered into the litter.

Click Add a puppy to add a puppy record.

Click Edit Selected Puppy or double-click a puppy to edit a puppy record.

Select a puppy and click Delete to remove it from the program.

Work with Puppies
If you choose the Puppies option on the Ribbon, you will receive the Work with Puppies window.  It is
very similar to the Puppies grid on the Litter information window, but lets you get to the puppy
information for a single litter more quickly.

The Work with Puppies window looks like this:
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The program has a grid that holds a listing of the puppies entered into the litter.

Click Add a puppy to add a puppy record.

Click Edit Selected Puppy or double-click a puppy to edit a puppy record.

Select a puppy and click Delete to remove it from the program.

Puppy Information
Popup

When you click to create or change a puppy, you get the Puppy Information pop-up.  This is where you
enter information about each puppy in the litter.

The Puppy Information Pop-up window looks like this:

Full Window

When you choose a puppy from Work with Puppies, you will get Puppy information in a full window.
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The Puppy Information Full Window looks like this:

The Puppy Information window (pop-up or full window) has the following fields:

Sequence:  The birth order of this puppy.  This number must be unique within the litter.  Two
puppies cannot be born first or fourth, etc.

Puppy Name: Enter whatever reference name or a registered name for the puppy.

Gender: Choose Male or Female.

Chip: Enter any chip number.

Tag/Tattoo: Enter any tag or tattoo information.

Reg. Number: Enter the individual puppy’s registration number if known.

Reg. Limited?:  If the puppy has a limited registration, choose Yes, otherwise choose No.

Status: Choose the puppy’s status…

o Kept

o Sold

o Given away

o Died

Disposition Date: The date that the puppy was sold, given or died.

Color: Coat coloration.

Comment: A free-form comment about the puppy.

Papers Provided?: Choose yes if papers were provided with the puppy at disposition.

Recipient:  This is a lookup control to choose a Contact to be the recipient of the puppy.

Bill of Sale Date: Enter the Bill of sale date if any.

Amount paid: Enter any amount paid for this puppy.

Reg. App. Date:  Enter any registration application date for this puppy.
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Reg. Cert. Date:  Enter any registration certificate date for this puppy.

Click Save to save the puppy.  When you do, the program will ask you if you want to create a
corresponding Animal record in My Dogs. Clicking yes will use the information to do so.  Clicking no will
not create a corresponding animal record.  Don’t worry, if you choose not to create an animal record,
just come back to the puppy and click save and if no corresponding animal record exists, the program
will ask you to create it again.

Click cancel to close the window without changing any data.

Once you have created a corresponding animal record, you will have the “Go to Puppy’s Animal Record”
option, which will take you to the puppy’s animal record.

If you have linked the wrong animal to a puppy, open the puppy and choose the “Detach Puppy’s
Animal Record” link.

Once a puppy is saved, you can then enter puppy tracking information.

Puppy Tracking
The program has the ability to keep metrics on each puppy day-by-day.  This information is stored on
the puppy’s tracking grid.  Click Add to add tracking information to a puppy, or select a tracking entry
and click edit (or double click) to change information, or select a tracking entry or click delete to
remove it from the program.

The Puppy tracking popup that you receive when choosing to add or edit looks like this:

You have the following fields:

Tracking Date and Time:  calendar date and time picker to choose the date and time of the
tracking.

Temperature: Puppy’s Temperature.

Weight: Puppy’s weight.

Length: Puppy’s length.
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Comment: A free form comment.

Click Save to save the tracking entry.

Click close to close the pop-up without changing any data.
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The Utility Tab

The Utility Menu
When you click the Utility Tab, The Breeder’s Standard® 2022 displays the Utility Menu.

The Utility Menu looks like this:

The Utility Menu gives you access to the various functions that appear on the Utility Tab:

Repair Database

Pack Database

Breeds

Registries

Titles

Vet Services

Shot Types

Transaction Types

Contact Types

Extra Fields

Contract Types
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G/L Accounts

Medication Types

Click on the option that you want to use.

Core Data Group

My Breeds
The Breeder’s Standard® 2022 keeps a table of breeds for the animals you keep in its database.  You
assign a breed to an animal when you import the animal or when you create an animal record in the
Animal info page.

The window lists each breed and its information.

The My Breeds window looks like this:

To add a breed, click Add.

To change a breed, click the breed and choose Change.

To delete the breed, click the breed and then choose Delete. NOTE: If the breed is assigned to one or
more animals, the program will not allow you to delete it. This is to protect the integrity of the database
and to keep you from losing animals.

Add/Change Breed Pop-Up

When you choose to add or change a breed, you will receive the Add/Change Breed Pop-Up.  This pop-
up window will collect the breed information and then save the record.

The Add/Change Breed pop-up looks like this:
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The fields you may enter are:

Breed Name:  Required.  The name of the breed.

Short Name: Used as a short (15 or fewer characters) name of the
breed for reference purposes.

Breed Code: Used for an ID code in animal registries that have breed
codes for competition or other purposes (e.g., the American Kennel
Club).

Variety Group:  Used to group varieties together to indicate that the
“Breed” record is for a variety of breed.  For example, you would
enter the same code for Smooth and wire haired fox terriers because
they may be crossbred and still registerable as pure-bred.

AKC Group:  This is the breed group number for registries that
group breeds for competition purposes such as AKC.

AKC?: Choose YES if this breed is officially recognized by AKC, no
otherwise.

Old Breed Name: Used for backward compatibility to merge
breeds properly from older PedFast Technology programs.

OFA Breed Code: Used to contain the two-or-three character breed
code used by the Orthopaedic Foundation for Animals for this breed.
In future versions, this will permit the program to import OFA
downloads directly into it.

Click Save to save the information into the database.

Click Close to close the pop-up without saving any information.
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My Titles
The Breeder’s Standard® 2022 keeps a table of titles for the animals you keep in its database.  You
assign a title to an animal when you import the animal or when you create an animal record in the
Animal info page.

The My Titles window looks like this:

The window lists each title and its information.

To add a title, click Add.

To change a title, click the title and choose Change.

To delete the title, click the title and then choose Delete. NOTE: If the title is assigned to one or more
animals, the program will not allow you to delete it. This is to protect the integrity of the database and to
keep you from losing animals.

Add/Change Title Pop-Up

When you choose to add or change a title, you will receive the Add/Change Title Pop-Up.  This pop-up
window will collect the title information and then save the record.

The Add/Change Title pop-up looks like this:
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The fields you may enter are:

Description:  Required.  The long name of the title.

Title: Required. The characters that make up the title.

Title Position:  Choose BEFORE NAME for titles that go before the animal name, and AFTER
NAME for those titles that go after the animal name.

Prefix:  If you have compound titles, such as BIS BISS Am. Can. Ch., on the BISS Ch. Title, for
example, you would put in BIS.  Then if the animal has multiple championships, you can select
these titles:

o BIS Champion

o BISS Champion

o American Champion

o Canadian Champion

o Champion

Then, if the animal’s prefix title (see below) is on the animal,
the program will use the Prefix characters instead of the Title
characters. This is optional.

Prefix Title: Type in the description of the title to look for as a condition to use the Prefix
instead of the full title.  This is optional.

Is AKC: Choose yes if this title is issued by the primary registry and should be printed on
show entry forms.

Category: Choose Basic Titles or Imported Titles.  Any title imported into the program by BXF
will have the Imported category assigned by the program.  This is for information only.

Click Save to save the information into the database.

Click Close to close the pop-up without saving any information.
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My Registries
The Breeder’s Standard® 2022 keeps a table of registries and certifications (e.g., OFA, CERF) for the
animals you keep in its database.  You assign registrations, linked to the animals to an animal when you
import the animal or when you create an animal record in the Animal info page (for primary
registration) or in the My Regs page for the animal for all other registrations and certifications.

The My Registries page looks like this:

The window lists each registry and its information.

To add a registry, click Add.

To change a registry, click the registry and choose Change.

To delete the registry, click the registry and then choose Delete. NOTE: If the registry is assigned to one
or more registrations on animals, the program will not allow you to delete it. This is to protect the
integrity of the database and to keep you from losing animals.

Add/Change Registry Pop-Up

When you choose to add or change a registry, you will receive the Add/Change Registry Pop-Up.  This
pop-up window will collect the registry information and then save the record.

The Add/Change Registry Pop-Up looks like this:
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The fields you may enter are:

Description:  Required.  The long name of the registry.

Registry Type: Choose from one of these types by typing in the name into the lookup control to
select:

o Domestic Registry

o Foreign Registry

o Medical Cert.

o Non-Medical Cert.

o Other

Short Name: An optional short name to be used on Pedigrees if present.

Status:  Choose Active or Inactive.  Inactive registries cannot be assigned to animal
registrations.

Click Save to save the information into the database.

Click Close to close the pop-up without saving any information.

Shot Types
The Breeder’s Standard® 2022 enables you to keep a distinct record of all vaccinations given to a dog.
These vaccinations are categorized as shot types. By using Add/Change Dog Vaccinations or this
window, you can add or change the shot types. Work with Shot types is on the Utility menu under Shot
Types.

Work with Shot Types looks like this:
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You have the following Links:

Create: This will cause the program to add a new record.

Edit: This will open the change window for the selected record. Double-clicking the left mouse
button will also do the same.

Remove: This will delete the highlighted record from the database, if it is not in use. Otherwise
a message is displayed.

Add/Change Shot Types

When you choose to add a shot type from Add/Change Dog Vaccination or from Work with Shot Types,
you will get the Add/Change Shot Type window.

The Add/Change Shot Type window looks like this:

You have the following fields to work with:

Description: This is the description for this shot.

Status: Choose Active or Inactive.
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Click the “Save” link to close this window and save your changes.

Click the “Close” link to close this window but to discard your changes.

Vet Visit Types
The Breeder’s Standard® 2022 enables you to store medical records and assign vet services to them
for the sake of grouping them and analyzing your medical usage. You can add new Vet Services from the
Add/Change Vet Visits window or from here. You can get to this window from the Utility menu, Vet
Services option.

Work with Vet Services looks like this:

You have the following Links:

Create: This will cause the program to add a new record.

Edit: This will open the change window for the selected record. Double-clicking the left mouse
button will also do the same.

Remove: This will delete the highlighted record from the database, if it is not in use. Otherwise
a message is displayed.

Add/Change Vet Services

When you choose to add or change a vet service from Add/Change Medical or Work with Vet Services,
you will get the Add/Change Vet Services window.

Add/Change Vet Services looks like this:
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You have the following fields to work with:

Description: This is the description for this service.

Service Type: What type this service is. Choose from

o Dental

o Fertility Services

o Grooming

o Other Services

o Testing

o Veterinary

Click the “Save” link to close this window and save your changes.

Click the “Cancel” link to close this window but to discard your changes.

Transaction Types
The Breeder’s Standard® 2022 enables you to group transactions by type. These transaction types
govern the way that certain reports (like dog ownership) work, and they can be added directly from
Add/Change Transaction. You can also add and change them here. Work with Transaction Types is
located on the Help Tab, Transaction Types option.

Work with Transaction Types looks like this:
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You have the following Links:

Create: This will cause the program to add a new record.

Edit: This will open the change window for the selected record. Double-clicking the left mouse
button will also do the same.

Remove: This will delete the highlighted record from the database, if it is not in use. Otherwise
a message is displayed.

Add/Change Transaction Types

When you type in a new name in Add/Change Transaction, or you choose to add or change a type in
Work with Transaction types, you will get the Add/Change Transaction Types window.

Add/Change Transaction Types looks like this:

You have the following fields to work with:

Description: This is the description for this type.
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AKC?: Choose Yes if this transaction affects AKC record keeping, “No” if it does not. With
previous versions of The Breeder’s Standard, this was an active field, but in this version it is a
comment.

Activity: What if any action this field has on record keeping. If the transaction type is an
equivalent to buying a dog, choose “Buy Animal.” This would include receiving as a gift, etc.
Same with Selling, choose “Sell animal” for giveaways, trades, etc. “Leasing” is for lease-related
transaction types.

Active?: Choose Active or inactive.

Click the “Save” link to close this window and save your changes.

Click the “Cancel” link to close this window but to discard your changes.

G/L Accounts
This window is another link to the GreenShade™ Chart of accounts.  It is explained in more detail at
the GreenShade Chart of Accounts section.

Contact Types
The Breeder’s Standard® 2022 enables you to group contact records by type. You are enabled to define
any number of contact types you wish. You may do this by typing in a new contact type name in
Add/Change contacts, or by accessing Work with Contact Types using the Contact Types option on the
Help Tab.

Work with Contact Types looks like this:

You have the following Links:

Create: This will cause the program to add a new record.

Edit: This will open the change window for the selected record. Double-clicking the left mouse
button will also do the same.

Remove: This will delete the highlighted record from the database, if it is not in use. Otherwise
a message is displayed.
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Add/Change Contact Type

You have the following fields to work with:

Description: This is the description for this contact type.

Click the “Save” link to close this window and save your changes.

Click the “Cancel” link to close this window but to discard your changes.

My Extra Field Types
The Breeder’s Standard® 2022 keeps a table of Extra Field Types.  These types allow you to create
special places to hold information not stored in the fields prepared for you in TBS 2022.  You can have
an unlimited number of extra fields per animal, but each one must have its own extra field type.  You
can get to these fields in the Extra Fields page for the animal.

The My Extra Field Types page looks like this:

The window lists each Extra Field and its information.

To add an Extra Field Type, click Add.

To change an Extra Field type, click the Extra Field and choose Change.

To delete the Extra Field, click the Extra Field and then choose Delete. NOTE: If the Extra Field is
assigned to one or more animals, the program will not allow you to delete it. This is to protect the
integrity of the database and to keep you from losing animals.

Add/Change Extra Field Pop-Up

When you choose to add or change an Extra Field, you will receive the Add/Change Extra Field Pop-Up.
This pop-up window will collect the Extra Field information and then save the record.

The Add / Change Extra Field Type Pop-Up looks like this:
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The fields you may enter are:

Description:  Required.  The long name of the Extra Field.

Short Name: An optional short name to be used on Pedigrees if present.

Click Save to save the information into the database.

Click Close to close the pop-up without saving any information.

Contracts
When you create or change transactions for a dog, you have an option to create a contract for that
transaction.  This is where you store the body text of the contract.

Unlike previous versions of The Breeder’s Standard®, version 2022 supports an unlimited number of
contract text forms.

Work with Contracts looks like this:

You have the following Links:
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Create: This will cause the program to add a new record.

Edit: This will open the change window for the selected record. Double-clicking the left mouse
button will also do the same.

Remove: This will delete the highlighted record from the database, if it is not in use. Otherwise
a message is displayed.

Add/Change Contract Text

When you choose to create or change contract text, you will receive the Add/Change Contract Text pop-
up.

The Add/Change Contract text pop-up looks like this:

You have the following fields to work with:

Description: A free form description for this contract.

Active?: Yes for active, no for inactive.

Contract Text: Once your attorney drafts the contract text, you may enter it in the program
through this field. Type in the text, hitting return only after a complete paragraph.  The contract
text is rich-text and supports font and formatting options.

Click Save to save the information into the database.

Click Close to close the pop-up without saving any information.

IMPORTANT From the License Agreement: You are notified that the Bill of Sale and Contract
produced by this software are not guaranteed to meet the legal requirements of your locality, and
expressly hold PedFast Technologies harmless for their use. You understand that contract text is not
provided to you, and that you are expected to retain the services of a licensed attorney in your locality
to draft contract language suitable to your needs. You, in any event, acknowledge that PedFast
Technologies has no liability in any circumstance with respect to the use or enforceability or legality of
any Contract or Bill of Sale produced by the Software.

Hints for Attorneys drafting Contracts for use in the Breeder’s Standard® 2022
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When drafting the contract language, have the client print up the contract for a transaction. This will
allow you to see the preamble and signature lines. You may also wish to see the Bill of Sale document
produced by The Breeder’s Standard 2022.

Refer to Selling party as SELLER.

Refer to purchasing party as BUYER.

Refer to the animal as DOG.

Refer to the consideration as PRICE.

If you wish your client to paste in rather than type in the text, then prepare it in Microsoft Word and
save it as RTF (Rich Text Format).  That will paste in and retain formatting.

Trait Types
The Breeder’s Standard® 2022 uses Trait types to keep track of traits for dogs. These traits can be
printed and also used in the Crystal Ball Genetics Engine . You can add trait types from Add/Change
Dog Traits or from Work with Trait Types. Work with Trait Types is accessed from the Help Tab, Trait
Types Option.

Work with Trait Types looks like this:

You have the following Links:

Create: This will cause the program to add a new record.

Edit: This will open the change window for the selected record. Double-clicking the left mouse
button will also do the same.

Remove: This will delete the highlighted record from the database, if it is not in use. Otherwise
a message is displayed.

Add/Change Trait Types

When you choose to add a trait type from Add/Change Traits or from Work with Trait Types, the
Add/Change Trait Types window is displayed.

The Add/Change Trait Types window looks like this:
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You have the following fields to work with:

Description: This is the description for this trait.

Characteristic: Choose from Dominant, Recessive, Polygenetic or Unknown.

Type: Choose from Behavioral, Coloration, Diseases or Type.

Status:  Active or Inactive.

Click Save to save the information into the database.

Click Close to close the pop-up without saving any information.

Medication Types
The Breeder’s Standard® 2022 uses Medication Types to track non-immunization medications for the
animals. You can add or change Medication types from this Work with Medication Types page. Work
with Medication Types is accessed from the Utility Tab, Medications Option.

Work with Medications looks like this:

You have the following Links:
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Create: This will cause the program to add a new record.

Edit: This will open the change window for the selected record. Double-clicking the left mouse
button will also do the same.

Remove: This will delete the highlighted record from the database, if it is not in use. Otherwise
a message is displayed.

Add/Change Medication Types

When you choose to add a Medication type from Add/Change Medication Types or from Work with
Medication Types, the Add/Change Medication Types window is displayed.

The Add/Change Medication Types page looks like this:

You have the following fields to work with:

Medication Name: The name of the medication.

Med. Type: Choose from Oral Tablet, Oral Liquid, Intranasal, injection or other,

Active?:  Active or Inactive.

Comment:  Type an optional free-form comment.

Click Save to save the information into the database.

Click Close to close the pop-up without saving any information.

Database Group

Repair Database
In the rare event that the .PTPED database somehow becomes corrupted, The Breeder’s Standard ®

2022 provides this database repair function. Use of this function without being advised to do so by
PedFast Technologies Product support is not recommended.
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In addition, you must make copy of your .PTPED file before attempting rebuild, or irretrievable
data loss may occur! We are not responsible for data loss.

The Repair Database window looks like this:

To repair the database, simply click on “Repair Current Database.”  The program will then rebuild the
database.

NOTE: Back up the database before repairing it. Do not shut off the program or your computer
until the program says that the Repair database operation is complete. If the database Repair is
interrupted, your database file could be irreparably and irretrievably lost. This is why it is so
important to make regular backups.

Clicking the “Exit” link will close the Repair Database page and go back to the Home Page.

Pack Database
The Breeder’s Standard® 2022 database technology is efficient and stores nicely into a single file.
However, as time goes on and records are changed, added and deleted, there are “holes” inside the
.PTPED file.  The Pack Database command cleans up these “holes” and reduces the file size.  It also
makes the database run faster.

The Pack Database page looks like this:
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To pack the database, simply click on “Pack Current Database.”  The program will then rebuild the
database.

NOTE: Back up the database before packing it. Do not shut off the program or your computer until
the program says that the pack database operation is complete. If the database pack is
interrupted, your database file could be irreparably lost. This is why it is so important to make
regular backups.

Clicking the “Exit” link will close the Pack Database page and go back to the Home Page.
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The Help Tab

The Help Menu
The Breeder’s Standard® 2022 has a Help tab with assistance options to help you use the program.
When you click the Help Tab, you receive the Help menu.

The Help Menu looks like this:

You use the Help Menu to access the program assistance functions.

The Help menu gives you access to the various functions that appear on the help tab:

Contact Support

Program Help

Puggsley™

Preferences

FAQ
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Support Group

Contact Support

The Contact support button on the Help Tab will use the built-in Web Browser to navigate to PedFast
Technologies’ Support Web site.  From there you may:

Read Support policies

Find online copies of user manuals

Search and read our Frequently-Asked Questions (FAQ) database

Open a product support ticket.

Requires an active Internet connection.

Program Help

Clicking the Program help button shows a pop-up window that pops up and contains the entire
program help text, based on this manual.

This same help is also available in the top right of the Window’s title bar, with a miniature icon:

Puggsley™
Puggsley™ is the mechanism in The Breeder’s Standard® to provide interactive help. On the Help Tab,
there is a toggle button to activate the Puggsley live help pane.  That button looks like this:

The same button appears in miniature in the top right of the window’s title bar, like this:
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Clicking the button once so that it is highlighted activates the Puggsley Panel, which shows help to the
right hand side of the window that is active.  Clicking so that it is inactive closes the Puggsley Panel and
hides the help.

The Puggsley™ Panel
The Puggsley Panel appears along the right hand side of the program when Puggsley is activated.

Here is an example:

Puggsley shows you the help of the window that you are on, and supports clicking links in the help file
and even printing the topic in the Puggsley Panel.  You have controls:

The Home button will go back to original topic – the help that is for the current window.  Use this to get
back if you click links inside of Puggsley™ to read about other help.

The left arrow will go back if you have navigated away from the original topic, the right arrow will go
forward if you have a place to go from which you went backwards.

The Printer button will print the topic in the window to your default printer, much as your web
browser will support printing.

The Breeder’s Standard® 2022 remembers the state of the Puggsley Panel when it closes, and will
reopen it if you had it opened last. MegaPed has its own Puggsley Panel and honors your Puggsley Panel
setting.

Preferences
In The Breeder’s Standard® 2022, you click the Preferences button:
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…to set up your preferences.

The Program Preferences window looks like this:

You have a few options that you can control:

Generate Primary Registrations for New Animals:  You can choose to have The Breeder’s
Standard® 2022 generate registration numbers.  Set “Yes” to generate or “No” to not do so.  The
Prefix are up to ten (10) characters that are put in front of a sequential number generated by
The Breeder’s Standard® 2022.  There will be no duplicates generated.

Check for Duplicate Primary Reg.?:  If checked, The Breeder’s Standard® 2022 will warn you
if you attempt to enter a new animal with the same primary registration as an existing animal.

MyPedFast™ Login Information:  You can enter new MyPedFast credentials, or delete
existing ones here.  You have additional choices to get a password reminder or an email to
reactivate an inactive MyPedFast account.
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Note: You must have valid MyPedFast™ credential to use MyActivate™ or
AutoUpdate™ III, or to get product support from PedFast Technologies™.

Click the Save button to save your changes.  However, changes to your MyPedFast™ credentials are
instantly saved.

FAQ
The Breeder’s Standard® 2022 contains a direct link to the PedFast Technologies™ knowledge base.
This base includes frequently-asked questions and their answers, and is updated as new issues are
encountered and solved.  You access the FAQ on this button on the Help Tab:

The FAQ page looks like this:

You navigate through the FAQ site as any other web page.  When you click the close link, you will be
brought back to the help menu.
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Troubleshooting Guide

What to Do when There’s Problem
What to Check

Try rebooting the computer if you get a goofy error or a shutdown message or an exception.  Before you
do that, however, write everything down so you have it handy if you need to contact us for support.

Information to have ready for Technical Support

When you call or post a message to PedFast Technologies, please have the following
information immediately available:

Your Control number, from the invoice and/or registration sheet;

The number (if any) and the full text of any message you’ve received.  Important!  Include the
full text of any message you receive!  These messages contain vital information we need to solve
problems.

Exactly what you did to receive this message;

What happened if you followed the steps outlined in the manual (if there were steps) to correct
the problem?

This will greatly help us to quickly identify and resolve your problems.

Contacting Product Support

From Inside the Program

On the Help Tab in the program we have a “life preserver” button that will contact our Product Support
site on the Internet.  As long as your computer is connected to the Internet, this is the fastest way to get
support for The Breeder’s Standard® 2021.

To use this feature, you simply need to click on the button and the program will contact our site and
send information to the site for us to help you.
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Internet
PedFast Technologies has one of the largest animal-related sites on the Internet.  On this site, we have
product news, demos, patches, free utilities and support information.  Our World Wide Web address is:

http://www.pedfast.com

We have a dedicated product support web site, complete with a searchable solution database and a
means to create support incident reports online.  That address is:

http://support.pedfast.com

Use the support website to report incidents to us and to receive responses through our new support
ticket system.  Direct email support has been retired in order to provide a more controlled and
documentable support experience.

Support Tickets
All product support is provided by our support ticket system.  You can access it on the web at
http://support.pedfast.com or by email to support@tickets.pedfast.com.  We will respond by email.

What we Need to Render Effective Help

Have you checked our FAQ?  We operate a Frequently-asked questions site that can answer many of
your questions quickly. You can reach this information on our support page.  We ask you to look in the
FAQ before opening a ticket.

Please reply to the ticket email or something else we send on your ticket, so that you don't open
multiple tickets.  Our ticketing system looks at the subject line of the email to know to what ticket to
link your reply.  That gives our technicians the ability to understand the context of the issue quickly,
which means you get a faster and better answer.  The ticket number appears in brackets in the subject
line.  Please don't remove or change that information.

We need as much information as possible.  We have to know what is going on - exactly - in order to
give you an effective answer or solution.

If you have a technical issue, we must know all of the following:

7. Exactly which program you are using.  This is not just the name, but the version number. Saying
that you have “your PedFast program” isn't helpful since we have over a dozen programs, and
many different versions.  A really great answer would be something like, “I have The Breeder's
Standard 2022, and my version is 15.0.13975.7200.”

8. Your operating system, and if you know it, 32-bit or 64-bit.  A good answer is something like, ”I
have Windows 7 Home Premium 64-bit.”  For a Mac, it would be something like, “I have OSX
Mojave.”

9. Exactly what happened.  A request that requires follow-up would be “My program isn't working
right.  Help!”  A really great request would be like, “I was entering an animal and pressed the
down arrow on Sire and no dogs came up, but I have many males in my database.”

If there is an error message we need the entire text of the error message, especially the first one
received.  If you get an “Unhandled Exception” error, we need you to click the “Details” button,
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highlight all of the details, and press CTRL+C to Copy, and then paste the message into an email
to this ticket by pressing CTRL+V.

10. If you have not given us all of this data, please do so now by replying to this notice with what we
need.  It will save us time and get you to your answer faster.

* NOTE:  We reserve the right to assess a fee for product support or to terminate it altogether.  The sale
of any product does not include any product support, which is offered solely as an accommodation.  No
sale is contingent upon any level of product support.  See the license agreement (Copyright and
License).

Abusive Conduct is Not Tolerated

We are people and we have feelings.

You may be frustrated, but that does not give you an excuse to be nasty, angry, insulting or threatening.
There is never an occasion where abuse is proper or tolerable.  PedFast Technologies is saddened that
its employees and contractors have been exposed to threats and abuse and is compelled to include
these warnings and protections.

It is unacceptable under the License Agreement to threaten the company, its representatives, its
products or its reputation in order to expedite support or express frustration.  It is unacceptable to
treat our representatives discourteously whether you are receiving electronic or telephone support.
The threat to cause a credit card reversal is included in these threats since you have agreed to an all
sales final purchase.

Frustration also does not give you the right to flame us on the Internet, which can give rise to legal
action to protect our rights.  Our support staff is instructed to terminate any support incident where the
person bringing the incident is discourteous or threatens or commits adverse action against the
company of any kind.  All such incidents are also grounds for us to permanently ban you from access to
our product support services and our web sites.

Any act that threatens us is grounds for the permanent termination of your support privileges with no
refund (all sales are final), and any written or verbal threat which we believe violates the law will be,
without delay or warning, reported to the authorities, and prosecuted to the fullest extent of the law.
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Maintenance

Back up Your Data
The Breeder’s Standard® 2022, unlike other programs PedFast Technologies™ has sold in the past,
stores data in a single file that can be placed anywhere on your computer, except in Program Files
or Windows system folder.  PedFast introduced the PTPED format with the TBS 2012 release.  We
recommend making a separate folder to hold the .PTPED file or storing it in your My Documents folder.

Once you have the location of the database secure, back it up frequently.  The program no longer has a
native backup capability, because the data are all stored on a single file.  You have the following options
for backing up:

Option 1: Back up with the Cloud

Microsoft provides OneDrive free of charge for a limited amount of data; if you store your .PTPED
database file in the One drive Documents folder, OneDrive automatically backs it up.

There are also cloud backup providers like iDrive, which accomplish the same kinds of backups.

Option 2: Manual Copy or CD Burn

Your other option is to back up the PTPED file by hand-copying it onto a stick drive or burning it onto a
CD or DVD media.  Since the database is a single file, you treat is as you would copying a Word
document or other simple file.

Restoring From Backup

To restore from a backup, simply copy the file into a folder where you can access it.  Them you only
need to use iPed™ 6G 2017 to open the database and you are back in business.

NOTE: If you have backed up the file onto CD or DVD, you will need to right click the file, choose
properties, and uncheck the “read only” option if it is checked. Some, but not all, CD/DVD restores will
leave the file marked “read only.”
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Glossary of Terms

Ahnentafel
An ahnentafel (German for “ancestor table”) or ahnenreihe (“ancestor series”) is a genealogical
numbering system for listing an animal’s direct ancestors in a fixed sequence of ascent. The subject
(proband or progenitor) of the ahnentafel is listed as No. 1, the subject’s father as No. 2 and the mother
as No. 3, the paternal grandparents as No. 4 and No. 5 and the maternal grandparents as No. 6 and No.
7, and so on, back through the generations. Apart from No. 1, who can be male or female, all even-
numbered individuals are male, and all odd-numbered individuals are female. In this schema, the
number of any individual’s father is double the individual’s number, and a individual’s mother is double
the individual’s number plus one. Using this definition of numeration, one can derive some basic
information about individuals who are listed without additional research.  The Breeder’s Standard ®

2012 uses Ahnentafel numbering in its Coefficient of Inbreeding and Coefficient of Relationship
screens.

AKC
The American Kennel Club, the largest pure-bred dog registry in the United States of America, and the
sanctioning body of most dog shows held in the United States..

BXF
BXF™ stands for Breeder’s Exchange Format, developed in 1993 by PedFast Technologies (then known
as Man’s Best Friend Software) as a means to reliably exchange dog, cat and horse ancestry
information.  This text-based format is the exclusive property of, and copyrighted by, PedFast
Technologies, and is used to import into and export from the PedFast Technology line of products
without worries about loss of data integrity.

Coefficient of Inbreeding
Dr. Sewall Wright, the most renowned geneticist of the 20 th century, defined an inbreeding coefficient.
This is a number which expresses the homozygosity (inbred like characteristics) of any animal as a
mathematical equation. This equation is now known as the “F” Coefficient, “COI” or “Inbreeding
Coefficient,” and is recognized as the standard in objectively measuring the amount of inbreeding in an
animal.
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The following is from “Animal Breeding” by Laurence M. Winters, University of Minnesota. Winters
stated that the formula for COI was developed by Dr. Wright, and published in 1922 in The American
Naturalist.

“The effects of inbreeding are the fixation of characters and increased prepotency; these are in direct
proportion to the percentage of homozygosis; the percentage of homozygosis is in direct proportion to
the degree of inbreeding.”

“The sire and dam of the inbred individual have a common ancestor or ancestors. The summation of the
coefficients for every line by which the parents are connected gives the coefficient of inbreeding of the
individual in question.”

“Each line is traced back from the sire to a common ancestor and then forward to the dam. It passes
through no individual more than once, but the same ancestors may occur in more than one line.”

The formula for obtaining the coefficient of inbreeding is

in which Fx and Fa are the coefficients for the individual and the common ancestor, respectively, and N
and N! are the number of generations between the common ancestor and the sire and dam,
respectively.

The Breeder’s Standard® 2012 calculates the COI through ten generations of ancestors. Its calculation
has been verified as accurate by Dr. Leslie B. Hansen, University of Minnesota.

Coefficient of Relationship
The coefficient of relationship is a measure of the degree of consanguinity (or biological relationship)
between two individuals. A coefficient of inbreeding can be calculated for an individual, as a measure
for the amount of pedigree collapse within that individual's genealogy. The term coefficient of
relationship was defined by Sewall Wright in 1922, and was derived from his definition of the
coefficient of inbreeding of 1921.

In general, the higher the level of inbreeding the closer the coefficient of relationship approaches a
value of 1, expressed as a percentage, and approaches a value of 0 for individuals with arbitrarily
remote common ancestors.

The formula of the Coefficient of Relationship is:

Where F(a) is the Sire’s Coefficient of inbreeding, F(b) is the Dam’s coefficient of Inbreeding and F(ab)
is the coefficient of inbreeding of any offspring of a mating between the two individuals.

COMPOUNDEX
COMPOUNDEX™ is a proprietary, patent-applied-for fuzzy-matching technology designed especially for
the multi-word registered names of dogs, cats and horses. It aids our duplicate checker technologies, to
give you the power you deserve and that our “competitors” cannot conceive.
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Contact
A “Contact” is any person or company which is affiliated in any way with the kennel. Examples of
contacts include breeders, owners, show judges, buyers or sellers of dogs and veterinarians. The
Breeder’s Standard® 2012 stores the name, address, phone numbers, Email address and comments for
contacts.

File-Open Dialog
This is a pop-up window that is used to choose an existing file to be opened.  In Windows 10, it looks
like this:

Choose the file you want by double clicking it or clicking it once and clicking Open.

OFA
The Orthopedic Foundation for Animals (OFA) is a not-for-profit organization based in Columbia,
Missouri that aims to research and prevent orthopedic and hereditary diseases in companion animals.

Prefix Title
“Prefix Titles” are titles for a Dog which precede the “Champion” title. Some examples of Prefix Titles
include “BIS Ch.”, Can. Ch.” and “Mex. Ch.” Proper use of Prefix titles will yield a combined title of “BIS
Can. Mex. Ch...” Generally, to make prefix titles work, add the Champion title after all of the specialized
titles, so that The Breeder’s Standard® 2012 knows the prefix titles are to be used.

PTPED
PTPED is the file extension for the PedFast Technologies Pedigree Database file.  It is a single file
database that holds all of your animal data.  It is easily backed up, and can even be opened and worked
with on a stick drive, network share or the like.

PTPED is a new technology, and is supported by all of our newer programs, making them all compatible
at the database level.

Registry
A registry is an organization that keeps records of animals and usually issues each animal an identifying
number.  Examples of registries include the American Kennel Club (AKC), Orthopedic Foundation for
Animals (OFA), and others.  The registry may be stud-book in nature, such as AKC, or medical in nature,
such as OFA.  The program does not limit you to those purposes, however.
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Save-As Dialog
A Save-As Dialog is a pop-up window that lets you choose the name of a file to be saved by The
Breeder’s Standard® 2012 and the drive and folder into which it will be saved.

The Save-As Dialog looks like this in Windows 10:

Navigate to the desired folder, type in a name, and click save.  If the file exists, you may be asked to
write over the file.

Stake Type
The Breeder’s Standard® 2012 supports 15 Working Trial stake types:

Open Puppy

Open Derby

Open Gun Dog

Open All-Age

Open Ltd. Gun

Open Ltd. All-Age

Backing In Gun

Am. Walk. Puppy

Am. Walk. Derby

Am. Gun Dog

Am. All-Age

Am. Ltd. Gun Dog

Am. Ltd. All-Age

Water Test
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